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1. Introduction
This chapter provides information you need to know before using the machine.
• Key benefits 5
• Features by models 7
• Useful to know 9
• About this user’s guide 10
• Safety information 11
• Machine overview 16
• Control panel overview 19
• Turning the machine ON 21
• Installing the driver locally 22
• Reinstalling the driver 24



Key benefits

Environmentally friendly

• To save toner and paper, this machine supports Eco feature (see "Eco 
printing" on page 39).

• To save paper, you can print multiple pages on one single sheet of paper 
(see "Using advanced print features" on page 136).

• To save paper, you can print on both sides of the paper (double-sided 
printing) (Manual) (see "Using advanced print features" on page 136).

• To save electricity, this machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

• We recommend using recycled paper for saving energy.

Fast high resolution printing

• You can print with a resolution of up to 1,200 x 1,200 dpi effective output.

• Fast, on-demand printing.

- For single-side printing, 20 ppm (A4) or 21 ppm (Letter).

Convenience

• Dell Printer Manager and Printing Status is a program that monitors and 
informs you of the machine’s status and allows you to customize the 
machine’s settings (see "Using Dell Printer Status" on page 163).

• Dell Scan Assistant is an application to help users scan, compile, and save 
documents in multiple formats, including .epub format. These documents 
can be shared via social networking sites.

• You can access Dell Support at www.dell.com or www.dell.com/support. 
Select your region on the WELCOME TO DELL SUPPORT page, and fill in the 
requested details to access help tools and information.

Wide range of functionality and application support

• Supports various paper sizes (see "Print media specifications" on page 73).

• Print watermark: You can customize your documents with words, such as 
“Confidential” (see "Using advanced print features" on page 136).

http://www.dell.com
http://www.dell.com/support


Key benefits

• Print posters: The text and pictures of each page of your document are 

magnified and printed across the multiple sheets of paper and can then be 
taped together to form a poster (see "Using advanced print features" on 
page 136).

• You can print in various operating systems (see "System requirements" on 
page 76).

AirPrint

• AirPrint allows you to wirelessly print directly from iPhone, iPad and iPod 
touch running iOS 4.2 or later.

Supports various wireless network setting method 

• Using the WPS (Wi-Fi Protected Setup™) button

- You can easily connect to a wireless network using the WPS button on 
the machine and the access point (a wireless router).

• Using the USB cable

- You can connect and set various wireless network settings using a USB 
cable.

• Using the Wi-Fi Direct

- You can conveniently print from your mobile device using the Wi-Fi or 
Wi-Fi Direct feature.

 

See "Introducing wireless set up methods" on page 109.

 



Features by models

Some features and optional goods may not be available depending on 
model or country.

Operating System

(●: Included, Blank: Not available) 

Software

(●: Included, Blank: Not available) 

Operating System  B1163 B1163w

Windows ● ●

Mac ● ●

Linux ● ●

Software  B1163  B1163w

SPL printer driver ● ●

XPS printer driver ● ●

Dell Printer Manager Scan to PC settings ● ●

Device Settings ● ●

Dell Scan Assistant ● ●

Dell Printer Status ● ●



Features by models

Variety feature

(●: Included, Blank: Not available) 

Features  B1163 B1163w

Hi-Speed USB 2.0 ● ●

Network Interface 802.11b/g/n wireless 

LANa

a. Depending on your country, wireless LAN card may not be available. For some counties, 
only 802.11 b/g can be applied. Contact your local Dell dealer or the retailer where you 
bought your machine.

● 

Eco printing (Control panel) ● ●

Duplex (2-sided) printing (Manual)b

b. Windows only.

● ●

Scan Scan to PC ● ●

PaperPort

14 (found in CD2)

(excluding China)

● ●

Copy

(see "Basic 
copying" on 
page 41)

ID card copying ● ●

Reduced or enlarged 
copying

● ●

Adjust background ● ●



Useful to know
The machine does not print.

• Open the print queue list and remove the document from the 
list (see "Canceling a print job" on page 37).

• Remove the driver and install it again (see "Installing the driver 
locally" on page 22).

• Select your machine as your default machine in your Windows 
(see "Setting your machine as a default machine" on page 135).

Where can I purchase accessories or supplies?

• Inquire at a Dell distributor or your retailer.

• Visit www.dell.com/supplies. Select your country/region to 
view product service information.

The status LED flashes or remains constantly on.

• Turn the product off and on again.

• Check the meanings of LED indications in this manual and 
troubleshoot accordingly (see "Understanding the status LED" 
on page 68).

A paper jam has occurred.

• Open and close the scan unit (see "Front view" on page 17).

• Check the instructions on removing jammed paper in this 
manual and troubleshoot accordingly (see "Clearing paper 
jams" on page 64).

Printouts are blurry.

• The toner level might be low or uneven. Shake the toner 
cartridge (see "Redistributing toner" on page 51).

• Try a different print resolution setting (see "Opening printing 
preferences" on page 37).

• Replace the toner cartridge (see "Replacing the toner 
cartridge" on page 53).

Where can I download the machine’s driver?

• You can get help, support application, machine drivers, 
manuals, and order information from the Dell website, 
www.dell.com > find your product > Support or Downloads.

http://www.dell.com
http://www.dell.com
http://www.dell.com/supplies
http://www.dell.com/supplies


About this user’s guide

This user's guide provides information for your basic understanding of the 
machine as well as detailed steps to explain machine usage.

• Read the safety information before using the machine.

• If you have a problem using the machine, refer to the troubleshooting 
chapter.

• Terms used in this user’s guide are explained in the glossary chapter.

• All illustrations in this user’s guide may differ from your machine depending 
on its options or model you purchased.

• The screenshots in this administrator’s guide may differ from your machine 
depending on the machine’s firmware/driver version.

• The procedures in this user’s guide are mainly based on Windows 7.

1 

Conventions

Some terms in this guide are used interchangeably, as below:

• Document is synonymous with original.

• Paper is synonymous with media, or print media.

• Machine refers to printer or MFP.

2 

General icons

Icon Text Description

Caution
Gives users information to protect the machine from 
possible mechanical damage or malfunction.

Note
Provides additional information or detailed 
specification of the machine function and feature.
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Safety information

These warnings and precautions are included to prevent injury to you and 
others, and to prevent any potential damage to your machine. Be sure to read 
and understand all of these instructions before using the machine. After reading 
this section, keep it in a safe place for future reference.

3 

Important safety symbols

Explanation of all icons and signs used in this chapter

4 

Operating environment

 Warning

Warning
Hazards or unsafe practices that may result in severe 
personal injury or death.

Caution
Hazards or unsafe practices that may result in minor 
personal injury or property damage.

Do not attempt.

Do not use if the power cord is damaged or if the electrical outlet is 
not grounded.

This could result in electric shock or fire. 

Do not place anything on top of the machine (water, small metal or 
heavy objects, candles, lit cigarettes, etc.).

This could result in electric shock or fire. 

• If the machine gets overheated, it releases smoke, makes 
strange noises, or generates an odd odor.Immediately turn off 
the power switch and unplug the machine.

• The user should be able to access the power outlet in case of 
emergencies that might require the user to pull the plug out.

This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power cord. 

Stepping on or allowing the power cord to be crushed by a heavy 
object could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not handle the 
plug with wet hands. 

This could result in electric shock or fire. 
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Safety information
 Caution
5 

Operating method

 Caution
During an electrical storm or for a period of non-operation, 
remove the power plug from the electrical outlet. 

This could result in electric shock or fire. 

Be careful, the paper output area is hot. 

Burns could occur. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections and 
request assistance from qualified service personnel.

Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these instructions 
have been followed, unplug the machine from all interface 
connections and request assistance from qualified service 
personnel.

Otherwise, this could result in electric shock or fire.

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 

Call an electrician to change the electrical outlet, or this could 
result in electric shock.

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.

This could result in electric shock or fire and/or injury to your pet. 

Do not forcefully pull the paper out during printing. 

It can cause damage to the machine.

Be careful not to put your hand between the machine and paper 
tray.

You may get injured.

Be care when replacing paper or removing jammed paper. 

New paper has sharp edges and can cause painful cuts.

When printing large quantities, the bottom part of the paper 
output area may get hot. Do not allow children to touch. 

Burns can occur.

When removing jammed paper, do not use tweezers or sharp metal 
objects. 

It can damage the machine.

Do not allow too many papers to stack up in the paper output tray.

It can damage the machine. 
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Safety information
6 

Installation / Moving

 Warning

 CautionDo not block or push objects into the ventilation opening.

This could result in elevated component temperatures which can 
cause damage or fire.

Use of controls or adjustments or performance of procedures other 
than those specified herein may result in hazardous radiation 
exposure.

This machine's power reception device is the power cord. 

To switch off the power supply, remove the power cord from the 
electrical outlet. 

Do not place the machine in an area with dust, humidity, or water 
leaks. 

This could result in electric shock or fire. 

Before moving the machine, turn the power off and disconnect all 
cords. The information below are only suggestions based on the 
units weight.If you have a medical condition that prevents you 
from lifting, do not lift the machine. Ask for help, and always use 
the appropriate amount of people to lift the device safety.

Then lift the machine:

• If the machine weighs under 20 kg (44.09 lbs), lift with 1 person.

• If the machine weighs 20 kg (44.09 lbs) - 40kg (88.18 lbs), lift 
with 2 people.

• If the machine weighs more than 40 kg (88.18 lbs), lift with 4 or 
more people.

The machine could fall, causing injury or machine damage.

Choose a flat surface with enough space for ventilation to place 
the machine. Also consider the space required to open the cover 
and trays. 

The place should be well-ventilated and be far from direct light, 
heat, and humidity. 

When using the machine for a long period of time or printing a 
large number of pages in a non-ventilated space, it could pollute 
the air and be harmful to your health. Place the machine in a well-
ventilated space or open a window to circulate the air periodically.

Do not place the machine on an unstable surface.

The machine could fall, causing injury or machine damage.
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Safety information

7 

Maintenance / Checking

 Caution

Use only No.26 AWGa or larger, telephone line cord, if necessary.

Otherwise, it can cause damage to the machine.

Make sure you plug the power cord into a grounded electrical 
outlet.

Otherwise, this could result in electric shock or fire.

Use the power cord supplied with your machine for safe 
operation. If you are using a cord which is longer than 2 meters (6 
feet) with a 110V machine, then the gauge should be 16 AWG or 
larger.

Otherwise, it can cause damage to the machine, and could result 
in electric shock or fire.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.

If the machine is not well-ventilated, this could result in fire.

Do not overload wall outlets and extension cords.

This can diminish performance, and could result in electric shock 
or fire.

The machine should be connected to the power level which is 
specified on the label.

If you are unsure and want to check the power level you are using, 
contact the electrical utility company.

a. AWG: American Wire Gauge

Unplug this product from the wall outlet before cleaning the 
inside of the machine. Do not clean the machine with benzene, 
paint thinner or alcohol; do not spray water directly into the 
machine. 

This could result in electric shock or fire. 

When you are working inside the machine replacing supplies or 
cleaning the inside, do not operate the machine.

You could get injured.

Keep cleaning supplies away from children. 

Children could get hurt.

Do not disassemble, repair or rebuild the machine by yourself. 

It can damage the machine. Call a certified technician when the 
machine needs repairing.

To clean and operate the machine, strictly follow the user's guide 
provided with the machine.

Otherwise, you could damage the machine.
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Safety information
8 

Supply usage

 Caution

Keep the power cable and the contact surface of the plug clean 
from dust or water.

Otherwise, this could result in electric shock or fire. 

• Do not remove any covers or guards that are fastened with 
screws. 

• Fuser units should only be repaired by a certified service 
technician. Repair by non-certified technicians could result in 
fire or electric shock.

• The machine should only be repaired by a Dell service 
technician.

Do not disassemble the toner cartridge.

Toner dust can be dangerous if inhaled or ingested.

Do not burn any of the supplies such as toner cartridge or fuser 
unit.

This could cause an explosion or uncontrollable fire.

When storing supplies such as toner cartridges, keep them away 
from children.

Toner dust can be dangerous if inhaled or ingested.

Using recycled supplies, such as toner, can cause damage to the 
machine.

In case of damage due to the use of recycled supplies, a service 
fee will be charged.

For supplies that contain toner dust (toner cartridge, waste toner 
bottle, imaging unit, etc.) follow the instructions below.

• When disposing of the supplies, follow the instructions for 
disposal. Refer to the reseller for disposal instructions.

• Do not wash the supplies.

• Do not reuse the waste toner bottle.

If you do not follow the instructions above, it may cause machine 
malfunction and environmental pollution. The warranty does not 
cover damages caused by a user's carelessness.

When toner gets on your clothing, do not use hot water to wash 
it.

Hot water sets toner into fabric. Use cold water.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.

Toner dust can be dangerous if inhaled or ingested.
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Machine overview

9 

Accessories

Power cord Quick installation guide

Software CDa

a. The software CD contains the print drivers, user’s guide, and software applications.

Misc. accessoriesb

b. Miscellaneous accessories included with your machine may vary by country of purchase and specific model.
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Machine overview

10 

Front view

 

• This illustration may differ from your machine depending on your model. 
There are various types of machine.

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7).

 

1 Scanner lid 7 Output tray

2 Control panel 8 Scanner glass

3 Handle 9 Scan unita b

 7
6

 1

 2

5

4

 8
 9

 10

 11

3

4 Tray 10 Inner cover

5 Tray handle 11 Toner cartridge

6 Output support

a. Close the scanner lid before opening the scan unit.
b. Be careful not to pinch your fingers.
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Machine overview

11 

Rear view

 

• This illustration may differ from your machine depending on your model. 
There are various types of machine.

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7).

 

1 USB 2.0 port 2 Power receptacle

1

2
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Control panel overview
1
Eco

Turn into eco mode to reduce toner consumption and 
paper usage when pc-printing only (see "Eco printing" 
on page 39). 

 12

 13

 2 Power 

Savera
Switches to Power save mode.

WPSb
Configures the wireless network connection easily 
without a computer (see "Using the WPS button" on 
page 110).

3 Scan to Sends scanned data (see "Basic Scanning" on page 43). 

4
ID Copy

Allows you to copy both sides of an ID card like a driver’s 
license on a single side of paper (see "ID card copying" 
on page 41). 

5
Power

Turns the power on or off, or wakes up the machine from 
the power save mode. If you need to turn the machine 
off, press this button for more than three seconds.

6
Front LED

When the LED lights on, place the front side of an ID card 
facing down on the scanner glass (see "ID card copying" 
on page 41). 

7
Back LED

When the LED lights on, place the back side of an ID card 
facing down on the scanner glass (see "ID card copying" 
on page 41). 
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Control panel overview
12 

Adjusting the control panel

 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Front view" on 
page 17).

 

8

Stop/
Clear

Stops an operation at any time and there are more 
functions.

• Cancels the current job.

• Prints configuration report: Press and hold this 
button for about 2 seconds until the status LED blinks 
slowly, and release. 

• Supplied Information report: Press and hold this 
button for about 6 seconds and release. 

• Network configuration reportb: Press and hold this 
button for about 4 seconds until the status LED blinks 
fast, and release.

9

+/- Buttons 

Allows you to increase/decrease the number of pages to 
copy. You can determine the number of copies (up to 99 
copies) to copy by pressing the +/- buttons. The default 
value is 1.

• If you press the +/- buttons, the number of copies will 
increase/decrease by one.

• If you press and hold the +/- buttons, the number of 
copies will increase/decrease by ten.

10
Start

Starts a job.

11
Status LED

Indicates the status of your machine (see 
"Understanding the status LED" on page 68). 

12
Toner LED

Shows the status of the toner (see "Understanding the 
status LED" on page 68). 

13 Display screen Shows the number of pages you want to copy.

a. B1163 only.
b. B1163w only.
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Turning the machine ON

1 Connect the machine to the electricity supply first.

Turn the switch on if the machine has a power switch.

 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Front view" on 
page 17).

 

2 Press  (Power) button on the control panel.

 

If you want to turn the power off, press and hold  (Power) button for 

about 3 seconds.
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Installing the driver locally

A locally connected machine is a machine directly attached to your computer 
using the cable.

 

• If you are a Mac or Linux operating systems user, refer to the "Installation 
for Mac" on page 97 or "Installation for Linux" on page 99. 

• The installation window in this User’s Guide may differ depending on the 
machine and interface in use.

• Only use a USB cable no longer than 3 meters (118 inches).

 

13 

Windows

1 Make sure that the machine is connected to your computer and 
powered on.

 

If the “Found New Hardware Wizard” appears during the installation 
procedure, click Cancel to close the window.

 

2 Insert the supplied software CD into your CD/DVD drive.

The software CD should automatically run and an installation window 
will appear.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

X:\Setup.exe replacing “X” with the letter, which represents your CD/
DVD drive and click OK.

• For Windows 8,

If the installation window does not appear, from Charms, select 
Search > Apps and search for Run. Type in X:\Setup.exe, replacing 
“X” with the letter that represents your CD/DVD drive and click OK.

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

3 Click New Printer. 

 (B1163)
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Installing the driver locally

(B1163w)

4 Choose USB. (B1163w only)

5 Follow the instructions on the installation window.

From the Windows 8 Start Screen

 

• If you install the driver using the supplied software CD, V4 driver is not 
installed. If you want to use the V4 driver in the Desktop screen, you can 
download from the Dell website (www.dell.com/support).

• If you want to install Dell’s printer management tools, you need to install 
them using the supplied software CD.

 

1 Make sure that your computer is connected to the Internet and powered 
on.

2 Make sure that the machine is powered on.

3 Connect the computer and the machine with a USB cable.

The driver is automatically installed from the Windows Update. 
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Reinstalling the driver

If the printer driver does not work properly, follow the steps below to reinstall 
the driver.

14 

Windows

1 From the Start menu, select Programs or All Programs > Dell Printers 
> your printer driver name > Uninstall.

• For Windows 8,

1 From Charms, select Search > Apps. 

2 Search and click Control Panel.

3 Click Programs and Features.

4 Right-click the driver you want to uninstall and select Uninstall. 

2 Follow the instructions in the installation window.

3 Insert the software CD into your CD/DVD drive and install the driver 
again (see "Installing the driver locally" on page 22).

From the Windows 8 Start Screen

1 Make sure that the machine is connected to your computer and 
powered on.

2 Click on the Uninstall Dell Printer Software tile in the Start screen.

3 Follow the instructions in the window.

 

• If you cannot find a Dell Printer Software tile, uninstall from the desktop 
screen mode. 

• If you want to uninstall Dell’s printer management tools, from the Start 
screen, right-click the app > Uninstall > right-click the program you 
want to delete > Uninstall and follow the instruction in the window. 
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2. Basic Setup
This chapter provides information about the the basic setup options.
• Media and tray 26
• Basic printing 36
• Basic copying 41
• Basic scanning 43



Media and tray

This chapter provides information on how to load print media into your 
machine.

 

• Using print media that does not meet these specifications may cause 
problems or require repairs. Such repairs are not covered by Dell’s 
warranty or service agreements.

• Make sure not to use the inkjet photo paper with this machine. It could 
cause damage to the machine. 

• Using inflammable print media can cause a fire.

• Use designated print media (see "Print media specifications" on page 73).

 

 

The use of inflammable media or foreign materials left in the printer may 
lead to overheating of the unit and, in rare cases may cause a fire.

 

1 

Tray overview

To change the size, you need to adjust the paper guides.

1 Paper width guide
2 Tray

 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Front view" on 
page 17).

 

 

If you do not adjust the guide, it may cause paper registration, image skew, 
or jamming of the paper.

 

1 

2 
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Media and tray

2 

Loading paper in the tray

 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Front view" on 
page 17).

 

1 Open the tray and then adjust the tray size to the media size you are 
loading (see "Tray overview" on page 26).

2 Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

3 Place the paper with the side you want to print facing up.

1 
2 
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Media and tray

 

• Do not push the paper width guide too far causing the media to warp.

• Do not use a paper with a leading-edge curl, it may cause a paper jam or 
the paper can be wrinkled.

• If you do not adjust the paper width guide, it may cause paper jams.

 

4 Squeeze the paper width guide and slide it to the edge of the paper stack 
without causing it to bend.

5 When you print a document, set the paper type and size for the tray.

 

The settings made from the machine driver override the settings on the 
control panel.

a To print in application, open an application and start the print menu.
b Open Printing Preferences (see "Opening printing preferences" on 

page 37).
c Press the Paper tab in Printing Preferences, and select an appropriate 

paper type. 
For example, if you want to use a label, set the paper type to Label.

d Select Auto Select (or Manual Feeder) in paper source, then press OK.
e Start printing in application.
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Media and tray

3 

Manual feeding in the tray

The tray can hold special sizes and types of print material, such as postcards, 
note cards, and envelopes (see "Print media specifications" on page 73). 

To manually feed paper in the tray, see "Loading paper in the tray" on page 27

 

Tips on using the manual feeding in tray

• If you select Paper > Source > Manual Feeder from your printer driver, 
you need to press OK each time you print a page.

• Load only one type, size and weight of print media at a time in the tray.

• To prevent paper jams, do not add paper while printing when there is still 
paper in the tray.

• Print media should be loaded face up with the top edge going into the 
tray first and be placed in the center of the tray.

• To ensure printing quality and to prevent paper jams, only load the 
available paper (see "Print media specifications" on page 73).

• Flatten any curl on postcards, envelopes, and labels before loading them 
into the in the tray.

• When printing on special media, you must follow the loading guidelines 
(see "Printing on special media" on page 29).

 

4 

Printing on special media

The table below shows the special media usable in tray. 

The media is also shown in the Printing Preferences. To get the highest 
printing quality, select the proper media type from the Printing preferences 
window > Paper tab > Paper Type (see "Opening printing preferences" on page 
37).

For example, if you want to print on labels, select Labels for Paper Type.

 

• When using special media, we recommend you feed one sheet at a time 
(see "Print media specifications" on page 73).

• Illustrations on this user’s guide may differ from your machine 
depending on its options or models. Check your machine type (see 
"Front view" on page 17).
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Media and tray

To see for paper weights for each sheet, refer to "Print media specifications" on 
page 73.

(●: Supported, Blank: Not supported) 

Envelope

Printing successfully on envelopes depends upon the quality of the envelopes. 

To print an envelope, place it as shown in the following figure.

• When selecting envelopes, consider the following factors:

- Weight: should not exceed 90 g/m2 otherwise; jams may occur.

- Construction: should lie flat with less than 6 mm curl and should not 
contain air.

- Condition: should not be wrinkled, nicked, nor damaged.

- Temperature: should resist the heat and pressure of the machine 
during operation.

• Use only well-constructed envelopes with sharp and well-creased folds.

• Do not use stamped envelopes.

• Do not use envelopes with clasps, snaps, windows, coated lining, self-
adhesive seals, or other synthetic materials.

Types Traya

a. The available paper types for manual feeding in the tray.

Plain ●

Thick ●

Thin ●

Bond ●

Color ●

CardStock ●

Labels ●

Envelope ●

Preprinted ●

Cotton ●

Recycled ●

Archive ●
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Media and tray

• Do not use damaged or poorly made envelopes.

• Be sure the seam at both ends of the envelope extends all the way to the 
corner of the envelope.

1 Acceptable
2 Unacceptable

• Envelopes with a peel-off adhesive strip or with more than one flap that 
folds over to seal must use adhesives compatible with the machine’s fusing 
temperature for 0.1 second about 170°C (338 °F). The extra flaps and strips 
might cause wrinkling, creasing, or jams, and may even damage the fuser.

• For the best print quality, position margins no closer than 15 mm from the 
edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Labels

To avoid damaging the machine, use only labels designed for use in laser 
printers.

• When selecting labels, consider the following factors:

- Adhesives: Should be stable at your machine’s fusing temperature 
about 170°C (338°F).

- Arrangement: Only use labels with no exposed backing between them. 
Labels can peel off sheets that have spaces between the labels, causing 
serious jams.

- Curl: Must lie flat with no more than 13 mm of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

• Make sure that there is no exposed adhesive material between labels. 
Exposed areas can cause labels to peel off during printing, which can cause 
paper jams. Exposed adhesive can also cause damage to machine 
components.
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• Do not run a sheet of labels through the machine more than once. The 

adhesive backing is designed for only a single pass through the machine.

• Do not use labels that are separating from the backing sheet or are wrinkled, 
bubbled, or otherwise damaged.

Card stock/ Custom-sized paper

• In the software application, set the margins to at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Preprinted paper

When loading preprinted paper, the printed side should be facing up with an 
uncurled edge at the front. If you experience problems with paper feeding, turn 
the paper around. Note that print quality is not guaranteed.

• Must be printed with heat-resistant ink that will not melt, vaporize, or 
release hazardous emissions when subjected to the machine’s fusing 
temperature for 0.1 second (about 170°C (338°F)).

• Preprinted paper ink must be non-flammable and should not adversely 
affect machine rollers.

• Before you load preprinted paper, verify that the ink on the paper is dry. 
During the fusing process, wet ink can come off preprinted paper, reducing 
print quality.
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5 

Using the output support

 

The surface of the output tray may become hot if you print a large number 
of pages at once. Make sure that you do not touch the surface, and do not 
allow children near it.

 

The printed pages stack on the output support, and the output support will help 
the printed pages to align. The printer sends output to the output tray by 
default.

 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Front view" on 
page 17).

 

6 

Preparing originals 

• Do not load paper smaller than 142 x 148 mm (5.6 x 5.8 inches) or larger than 
216 x 356 mm (8.5 x 14 inches).

• Do not attempt to load the following paper in order to prevent paper jam, 
low print quality and machine damage.

- Carbon-paper or carbon-backed paper

- Coated paper

- Onion skin or thin paper

- Wrinkled or creased paper

- Curled or rolled paper

- Torn paper

• Remove all staples and paper clips before loading.

• Make sure any glue, ink, or correction fluid on the paper is completely dry 
before loading.

• Do not load originals that include different sizes or weights of paper.

• Do not load booklets, pamphlets, transparencies, or documents with other 
unusual characteristics.
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7 

Loading originals

You can use the scanner glass to load an original for copying and scanning.

 

Illustrations on this user’s guide may differ from your machine depending 
on its options or models. Check your machine type (see "Front view" on 
page 17).

 

On the scanner glass

Using the scanner glass, you can copy or scan originals. You can get the best 
scan quality, especially for colored or gray-scaled images.

1 Lift and open the scanner lid.
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2 Place the original face down on the scanner glass. Align it with the 

registration guide at the top left corner of the glass.

3 Close the scanner lid.

 

• Leaving the scanner lid open while copying may affect copy quality and 
toner consumption.

• Dust on the scanner glass may cause black spots on the printout. Always 
keep it clean (see "Cleaning the machine" on page 55).

• If you are copying a page from a book or magazine, lift the scanner lid 
until its hinges are caught by the stopper and then close the lid. If the 
book or magazine is thicker than 30 mm, start copying with the scanner 
lid open.

 

 

• Be careful not to break the scanner glass. You may get hurt.

• Do not put hands while closing the scanner lid. The scanner lid may fall 
on your hands and get hurt.

• Do not look the light from inside of the scanner while copying or 
scanning. It is harmful to eyes.
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For special printing features, refer to the Advanced Guide (see "Using 
advanced print features" on page 136).

 

8 

Printing

 

• If you are a Mac or Linux operating systems user, refer to the Advanced 
Guide (see "Mac printing" on page 144 or "Linux printing" on page 146).

• For Windows 8 user, see "Basic printing" on page 36.

 

The following Printing Preferences window is for Notepad in Windows 7.

1 Open the document you want to print.

2 Select Print from the File menu.

3 Select your machine from the Find Printer list.

4 The basic print settings including the number of copies and print range 
are selected within the Print window. 

 

To take advantage of the advanced printing features, click Properties or 
Preferences from the Print window (see "Opening printing preferences" on 
page 37).

 

5 To start the print job, click OK or Print in the Print window.
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Canceling a print job

If the print job is waiting in the print queue or print spooler, cancel the job as 
follows:

• You can access this window by simply double-clicking the machine icon 

( ) in the Windows task bar. 

• You can also cancel the current job by pressing (Stop/Clear) on the 

control panel.

10 

Opening printing preferences

 

• The Printing Preferences window that appears in this user’s guide may 
differ depending on the machine in use. 

• When you select an option in Printing Preferences, you may see a 
warning mark  or . An  mark means you can select that certain 

option but it is not recommended, and an  mark means you cannot 
select that option due to the machine’s setting or environment.

 

1 Open the document you want to print.

2 Select Print from the file menu. The Print window appears. 

3 Select your machine from the Find Printer. 
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4 Click Properties or Preferences. 

 

You can check the machine’s current status pressing the Printer Status 
button (see "Using Dell Printer Status" on page 163).

 

Customize Print Preferences

The Presets option, which is visible on each preferences tab except for the Dell 
tab, allows you to save the current preferences for future use.

To save a Presets item, follow these steps:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Presets input box.

3 Click  (Add). When you save Presets, all current driver settings are 
saved.
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Select more options and click  (Update), settings will be added to the 
Presets you made. To use a saved setting, select it from the Presets drop-
down list. The machine is now set to print according to the settings you 
have selected.To delete saved settings, select it from the Presets drop-

down list and click  (Delete). 

You can also restore the printer driver’s default settings by selecting 
Default Preset from the Presets drop-down list.

 

11 

Using help

Click the option you want to know on the Printing Preferences window and 
press F1 on your keyboard.

12 

Eco printing

The Eco function cuts toner consumption and paper usage. The Eco function 
allows you to save print resources and lead you to eco-friendly printing.

If you press the Eco button from the control panel, eco mode is enabled. The 
default setting of Eco mode is Multiple Pages per Side (2) and Toner Save.

Setting eco mode on the driver

Open the Eco tab to set Eco mode. When you see the eco image ( ), that 
means the eco mode is currently enabled.

Eco options

• Printer Default: Follows the settings from the machine's control panel.

• None: Disables Eco mode.

• Eco Printing: Enables eco mode. Activate the various Eco items you want to 
use.

• Password: If the administrator fixed to enable the Eco mode, you have to 
enter the password to change the status.
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Result simulator

Result Simulator shows the results of reduced emission of carbon dioxide, used 
electricity, and the amount of saved paper in accordance with the settings you 
selected.

• The results are calculated on the basis that the total number of printed 
paper is one hundred without a blank page when the Eco mode is disabled.

• Refers to the calculation coefficient about CO2, energy, and paper from IEA, 
the index of Ministry of Internal Affairs and Communication of Japan and 
www.remanufacturing.org.uk. Each model has a different index. 

• The power consumption in printing mode refers to the average printing 
power consumption of this machine. 

• The actual amount displayed is only an estimate as the actual amount may 
differ depending on the operating system used, computing performance, 
application software, connection method, media type [thickness], media 
size, job complexity, etc.
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Basic copy

1 Place a single document face down on the document glass (see "Loading 
originals" on page 34).

2 If you want to customize the copy settings such as Reduce/Enlarge, 
Darkness, Contrast or Original Type, from Dell Printer Manager, click 
the Device Setting tab > Copy tab (see "Using Dell Printer Manager" on 
page 160).

3 Enter the number of copies using “+” or “-” button, if necessary.

4 Press (Start).

 

If you need to cancel the copying job during the operation, press  

(Stop/Clear) and the copying will stop.

 

14 

ID card copying

Your machine can print 2-sided originals on one sheet.

The machine prints one side of the original on the upper half of the paper and 
the other side on the lower half without reducing the size of the original. This 
feature is helpful for copying a small-sized item such as business card.

 

• The original must be placed on the scanner glass to use this feature.

• If the machine set to Eco mode, this feature is not available.

 

Depending on the model, the operating procedure may differ.

1 Press ID Copy on the control panel.

2 Place the front side of an original facing down on the scanner glass 
where arrows indicate as shown. Then, close the scanner lid.
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3 Place Front Side and Press [Start] appears on the display.

4 Press  (Start).

Your machine begins scanning the front side and shows Place Back Side 
and Press [Start].

5 Turn the original over and place it on the scanner glass where arrows 
indicate as shown. Then, close the scanner lid.

6 Press  (Start) button.

 

• If you do not press the  (Start) button, only the front side will be 
copied.

• If the original is larger than the printable area, some portions may not be 
printed.
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For special scanning features, refer to the Advanced Guide (see "Scan 
features" on page 148).

 

15 

Basic Scanning

This is the normal and usual procedure for scanning originals.

This is a basic scanning method for USB-connected machine.

1 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 34).

2 Press Scan to on the control panerl.

 

If you see Not Available message, check the port connection, or select 

Enable Scan from Device Panel in Dell Printer Manager > Switch to 
advanced mode > Scan to PC Settings.

 

3 Select the scan destination you want and press OK.

Default setting is My Documents.

 

• You can create and save the frequently used settings as a profile list. Also 
you can add and delete the profile and save each profile to a different 
path.

• To manage profiles in Dell Printer Manager > Switch to advanced 
mode > Scan to PC Settings.

 

4 Select the option you want and press Save.

5 Scanning begins.

 

Scanned image is saved in computer’s C:\Users\users name\My 
Documents. The saved folder may differ, depending on your operating 
system or the application you are using.
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3. Maintenance
This chapter provides information about purchasing supplies, accessories and maintenance parts available for your 
machine.
• Ordering supplies and accessories 45
• Available supplies 46
• Available maintenance parts 47
• Installing accessories 48
• Storing the toner cartridge 49
• Redistributing toner 51
• Replacing the toner cartridge 53
• Cleaning the machine 55
• Tips for moving & storing your machine 61



Ordering supplies and accessories

 

Available accessories may differ from country to country. Contact your sales representatives to obtain the list of available supplies, and maintenance parts.

 

To order Dell-authorized supplies, accessories, and maintenance parts, contact your local Dell dealer or the retailer where you purchased your machine. You can also 
visit www.dell.com/supplies, and then select your country/region to obtain the contact information for service.
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Available supplies

When supplies reach the end of their life spans, you can order the followings of supplies for your machine:

 

Depending on the options, percentage of image area and job mode used, the toner cartridge’s lifespan may differ.

 

 

When purchasing new toner cartridges or other supplies, these must be purchased in the same country as the machine you are using. Otherwise, new toner 
cartridges or other supplies will be incompatible with your machine due to different configurations of toner cartridges and other supplies according to the specific 
country conditions.

 

 

Dell does not recommend using non-genuine Dell toner cartridge such as refilled or remanufactured toner. Dell cannot guarantee non-genuine Dell toner cartridge's 
quality. Service or repair required as a result of using non-genuine Dell toner cartridges will not be covered under the machine’s warranty.

 

Type Average yielda

a. Declared yield value in accordance with ISO/IEC 19752. The number of pages may be affected by operating environment, printing interval, graphics, media type and media size.

Part name

Toner cartridge Approx. 1,500 pages YK1PM (All countries except China)

15RRN (For China only)
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Available maintenance parts

To purchase maintenance parts, contact the source where you bought the machine. Replacing maintenance parts can be performed only by an authorized service 
provider, dealer, or the retailer where you bought the machine. The warranty does not cover the replacement of any maintenance parts once it has reached its 
“Average yield”.

Maintenance parts are replaced at specific intervals to avoid print quality and paper feed problems resulting from worn parts, see table below. The purpose of which 
is to maintain your machine in top working condition. The maintenance parts below should be replaced when the life span of each item has been met.

Parts Average yielda

a. It will be affected by the operating system used, computing performance, application software, connecting method, media, media size and job complexity.

Transfer Roller Approx. 30,000 pages 

Fuser Unit Approx. 30,000 pages

Pick-Up Roller Approx. 30,000 pages

Feed Roller Approx. 30,000 pages
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Installing accessories

When you install optional devices, such as optional tray, memory, etc, this 
machine automatically detects and sets the optional devices. If you cannot use 
the optional devices you installed in this driver, you can set the optional devices 
in Device Settings to use.

1 Click the Windows Start menu.

• For Windows XP/2003, select Printers and Faxes.

• For Windows 2008/Vista, select Control Panel > Hardware and 
Sound>Printers.

• For Windows 7, select Control Panel > Hardware and 
Sound>Device and Printers.

• For Windows Server 2008 R2, select Control Panel > 
Hardware>Device and Printers.

• For Windows 8, from the Charms, select Search > Settings.

• For Windows 8, search for Device and Printers.

2 Right-click your machine.

3 For Windows XP/2003/2008/Vista, press Properties.

• For Windows 7, Windows Server 2008 R2, and Windows 8, from 
context menus, select Printer properties.

 

If Printer properties item has a ▶mark, you can select other printer drivers 
connected with the selected printer.

 

4 Select Device Options or Device Settings.

 

The Printer properties window may differ depending on the driver or 
operating system you are using.

 

5 Select the appropriate option.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

• Tray Options: Select the optional tray you installed. You can select 
the tray.

• Storage Options: Select the optional memory you installed. If this 
feature is checked, you can select the Print Mode.

• Printer Configuration: Select the printer language for the print job.

• Administrator Settings: You can select the Printer status and EMF 
Spooling.

• Custom Paper Size Settings: You can specify custom paper size.

6 Click OK until you exit the Printer properties window.
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Storing the toner cartridge

Toner cartridges contain components that are sensitive to light, temperature 
and humidity. Dell suggests users follow these recommendations to ensure 
optimal performance, highest quality, and longest life from your new Dell toner 
cartridge.

Store this cartridge in the same environment in which the printer will be used. 
This should be in controlled temperature and humidity conditions. The toner 
cartridge should remain in its original and unopened package until installation 
– if original packaging is not available, cover the top opening of the cartridge 
with paper and store in a dark cabinet.

Opening the cartridge package prior to use dramatically shortens its useful shelf 
and operating life. Do not store on the floor. If the toner cartridge is removed 
from the printer, follow the instructions below to store the toner cartridge 
properly.

• Store the cartridge inside the protective bag from the original package. 

• Store lying flat (not standing on end) with the same side facing up as if it 
were installed in the machine.

• Do not store consumables in any of the following conditions:

- Temperature greater than 40°C (104°F).

- Humidity range less than 20% or greater than 80%.

- An environment with extreme changes in humidity or temperature.

- Direct sunlight or room light.

- Dusty places.

- A car for a long period of time.

- An environment where corrosive gases are present.

- An environment with salty air.

1 

Handling instructions

• Do not touch the surface of the photoconductive drum in the cartridge.

• Do not expose the cartridge to unnecessary vibrations or shock.

• Never manually rotate the drum, especially in the reverse direction; this can 
cause internal damage and toner spillage.

2 

Toner cartridge usage

Dell Inc. does not recommend or approve the use of non-Dell brand toner 
cartridges in your printer including generic, store brand, refilled, or 
remanufactured toner cartridges.

 

Dell’s printer warranty does not cover damage to the machine caused by 
the use of a refilled, remanufactured, or non-Dell branded toner cartridges.
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Estimated cartridge life

Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print yield may vary 
depending on the print density of the pages you print on, operating 
environment, percentage of image area, printing interval, media type and/or 
media size. For example, if you print a lot of graphics, the consumption of the 
toner is higher and you may need to change the cartridge more often.
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Redistributing toner

When the toner cartridge is near the end of its life:

• White streaks or light printing occurs and/or density variation side to side. 

• The Status LED blinks red. In the case of machine with a Toner LED, it blinks orange. 

If this happens, you can temporarily improve print quality by redistributing the remaining toner in the cartridge. In some cases, white streaks or light printing will still 
occur even after you have redistributed the toner.

 

Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).

 

 

• To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes. Cover it with a piece of paper, if necessary. 

• Do not touch the green area of the toner cartridge. Use the handle on the cartridge to avoid touching this area. 

• Do not use sharp objects such as a knife or scissors to open the toner cartridge package. They might scratch the drum of the cartridge.

• If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.

• When opening a scan unit, hold the document feeder and scan unit together.
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Redistributing toner
1 

 2 
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Replacing the toner cartridge

 

• Shake the toner cartridge thoroughly, it will increase the initial print quality.

• Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).

 

 

• To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes. Cover it with a piece of paper, if necessary. 

• Do not touch the green area of the toner cartridge. Use the handle on the cartridge to avoid touching this area. 

• Do not use sharp objects such as a knife or scissors to open the toner cartridge package. They might scratch the drum of the cartridge.

• If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.

• When opening a scan unit, hold the document feeder and scan unit together.

 

When a toner cartridge has reached the end of life, the machine will stop printing.
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Cleaning the machine

If printing quality problems occur or if you use your machine in a dusty environment, you need to clean your machine regularly to keep it in the best printing 
condition and use your machine longer.

 

• Cleaning the cabinet of the machine with cleaning materials containing large amounts of alcohol, solvents, or other strong substances can discolor or distort the 
cabinet. 

• If your machine or the surrounding area is contaminated with toner, we recommend you use a cloth or tissue dampened with water to clean it. If you use a vacuum 
cleaner, toner blows in the air and might be harmful to you.

 

4 

Cleaning the outside

Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth slightly with water, but be careful not to let any water drip onto or into the machine.
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5 

Cleaning the inside

During the printing process, paper, toner, and dust particles can accumulate inside the machine. This buildup can cause print quality problems, such as toner specks 
or smearing. Cleaning the inside of the machine clears and reduces these problems.

 

• To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes. Cover it with a piece of paper, if necessary. 

• Do not touch the green area of the toner cartridge. Use the handle on the cartridge to avoid touching this area. 

• Use a dry lint free cloth when cleaning the inside of the machine, be careful not to damage the transfer roller or any other inside parts. Do not use solvents such 
as benzene or thinner. Printing quality problems can occur and cause damage to the machine.

 

 

• Use a dry lint-free cloth to clean the machine.

• Turn the machine off and unplug the power cord. Wait for the machine to cool down. If your machine has a power switch, turn the power switch off before 
cleaning the machine.

• Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).

• When opening a scan unit, hold the document feeder and scan unit together.
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1

 2
573. Maintenance



Cleaning the machine

6 

Cleaning the pickup roller

 

• Turn the machine off and unplug the power cord. Wait for the machine to cool down. If your machine has a power switch, turn the power switch off before 
cleaning the machine.

• Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).
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Cleaning the machine

7 

Cleaning the scan unit

Keeping the scan unit clean helps ensure the best possible copies. We suggest that you clean the scan unit at the start of each day and during the day as needed.

 

• Turn the machine off and unplug the power cord. Wait for the machine to cool down. If your machine has a power switch, turn the power switch off before 
cleaning the machine.

• Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).

 

1 Slightly dampen a soft, lint-free cloth or paper towel with water.

2 Lift and open the scanner lid.
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3 Wipe the scanner glass until it is clean and dry.

1 Scanner lid
2 Scanner glass
3 White sponge sheet

4 Close the scanner lid.

 1

 2

 3
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Tips for moving & storing your machine

 

• When moving the machine, do not tilt or turn it upside down. Otherwise, the inside of the machine may be contaminated by toner, which can cause damage to 
the machine or reduce print quality.

• When moving the machine, make sure at least two people are holding the machine securely. 
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4. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
• Tips for avoiding paper jams 63
• Clearing paper jams 64
• Understanding the status LED 68
 

This chapter gives helpful information for what to do if you encounter an error. If your machine 
has a display screen, check the message on the display screen first to solve the error.If you 
cannot find a solution to your problem in this chapter, refer to the Troubleshooting chapter in 
the Advanced Guide (see "Troubleshooting" on page 168).If you cannot find a solution in the 
User's Guide or the problem persists, call for service. 

 



Tips for avoiding paper jams

By selecting the correct media, most paper jams can be avoided. To avoid paper jams, refer to the following guidelines:

• Ensure that the adjustable guides are positioned correctly (see "Tray overview" on page 26).

• Do not remove paper from the tray while your machine is printing.

• Flex, fan, and straighten paper before loading. 

• Do not use creased, damp, or highly curled paper.

• Do not mix papers in a tray.

• Use only recommended print media (see "Print media specifications" on page 73).
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Clearing paper jams

 

To avoid tearing the paper, pull the jammed paper out slowly and gently. 

 

1 

In tray

 

Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).
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Clearing paper jams

2 

Inside the machine

 

• The fuser area is hot. Take care when removing paper from the machine.

• Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 17).
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Clearing paper jams
1

 2
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Clearing paper jams

If you do not see the paper in this area, stop and go to next step:
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Understanding the status LED

The color of the LED indicates the machine's current status.

 

• Some LEDs may not be available depending on model or country (see "Control panel overview" on page 19).

• To resolve the error, look at the error message and its instructions from the troubleshooting part. 

• You also can resolve the error with the guideline from the computers’s Dell Printing Status (see "Using Dell Printer Status" on page 163 ).

• If the problem persists, call a service representative.

 

 

LED Status Description

Status

Off The machine is off-line.

Green
Blinking When the backlight blinks, the machine is receiving or printing data.

On • The machine is on-line and can be used.

Red

Blinking

• A minor error has occurred and the machine is waiting for the error to be cleared. Check the display message. When the problem 
is cleared, the machine resumes.

• Small amount of toner is left in the cartridge. The estimated cartridge lifea of toner is close. Prepare a new cartridge for 
replacement. You may temporarily increase the printing quality by redistributing the toner (see "Redistributing toner" on page 

51).b

On

• A toner cartridge has almost reached its estimated cartridge lifea. It is recommended to replace the toner cartridge (see 
"Replacing the toner cartridge" on page 53).

• The cover is opened. Close the cover.

• There is no paper in the tray when receiving or printing data. Load paper in the tray. 

• The machine has stopped due to a major error. Check the display message. 

• A paper jam has occurred (see "Clearing paper jams" on page 64).
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Understanding the status LED
 

( ) 

WPSb
Blue

Blinking The machine is connecting to a wireless network.

On The machine is connected to a wireless network (see "Wireless network setup" on page 108).

Off The machine is disconnected from a wireless network.

( ) 

Power/
Wakeup 

Blue

On The machine is in power save mode.

Off
The machine is in ready mode or machine’s power is off.

Eco Green

On Eco mode is on. 

The default setting of Eco mode is 2-up and toner save.

Off Eco mode is off. 

Tonerb Orange

Blinking Small amount of toner is left in the cartridge. The estimated cartridge lifea of toner is close. Prepare a new cartridge for replacement. 
You may temporarily increase the printing quality by redistributing the toner (see "Redistributing toner" on page 51).

On A toner cartridge has almost reached its estimated cartridge lifea. It is recommended to replace the toner cartridge (see "Replacing 
the toner cartridge" on page 53).

Off All toner cartridges are at normal capacity.

a. Estimated cartridge life means the expected or estimated toner cartridge life, which indicates the average capacity of print-outs and is designed pursuant to ISO/IEC 19752. The number of pages 
may be affected by operating environment, percentage of image area, printing interval, graphics, media and media size. Some amount of toner may remain in the cartridge even when red LED is 
on and the printer stops printing.

b. Some LEDs may not be available depending on model or country (see "Control panel overview" on page 19).

LED Status Description
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5. Appendix
This chapter provides product specifications and information concerning applicable regulations.
• Specifications 71
• Regulatory information 80
• Copyright 93



Specifications

1 

General specifications

 

The specification values listed below are subject to change without notice. See www.dell.com for possible changes in information.

 

 

Items Description

Dimension Width x Length x Height B1163/B1163w 389 x 274 x 249 mm (15.31 x 10.79 x 9.80 inches) 

Weight Machine with consumables B1163/B1163w 7.5 Kg (16.53 lbs)

Noise Levela Ready mode Less than 27 dB (A)

Print mode Less than 50 dB (A)

Copy mode Scanner glass Less than 50 dB (A)

Document feeder Less than 52 dB (A)

Scan mode Scanner glass Less than 52 dB (A)

Temperature Operation 10 to 32°C (50 to 89.6°F)

Storage (packed) 0 to 40°C (-4 to 104°F)

Humidity Operation 20 to 80% RH

Storage (packed) 10 to 80% RH

Power ratingb 110 volt models AC 110 - 127 V

220 volt models AC 220 - 240 V
715. Appendix

http://www.dell.com


Specifications
 

Power consumption Average operating mode Less than 270 W

Ready mode Less than 75 W

Power save modec Less than 3 W 

Power off moded Less than 0.5 W

Wireless Module SPW-B4319S

a. Sound Pressure Level, ISO 7779. Configuration tested: basic machine installation, A4 paper, simplex printing.
 China only: If the equipment's noise is louder than 63 db (A) ,the equipment should be placed in region of relatively independent advice.
b. See the rating label on the machine for the correct voltage (V), frequency (hertz) and of current (A) for your machine.
c. The power consumption of power save mode may be affected by machine's status, setting conditions, operating environment.
d. Power consumption can be completely avoided only when the power cable is not connected.

Items Description
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Print media specifications 

 

Type Size Dimensions
Print media weight/Capacitya

Tray Manual feeding in trayb

Plain paper

Letter 216 x 279 mm (8.5 x 11 inches) 71 to 85 g/m2 (19 to 23 lbs bond) 

• 150 sheets of 80 g/m2 (21 lbs 
bond)

71 to 85 g/m2 (19 to 23 lbs bond) 

• 1 sheetLegal 216 x 356 mm (8.5 x 14 inches)

US Folio 216 x 330 mm (8.5 x 13 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

JIS B5 182 x 257 mm (7.17 x 10.12 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)

Envelope

Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches) 75 to 90 g/m2 (20 to 24 lbs bond)

• 10 sheets

75 to 90 g/m2 (20 to 24 lbs bond)

• 1 sheetEnvelope No. 10 105 x 241 mm (4.12 x 9.5 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.38 x 9.02 inches)
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Thick paper
Refer to the Plain 
paper section 

Refer to the Plain paper section 86 to 120 g/m2 (23 to 32 lbs 
bond)

• 50 sheets of 120 g/m2 (32 lbs 
bond)

86 to 120 g/m2 (23 to 32 lbs bond)

• 1 sheet

Thin paper
Refer to the Plain 
paper section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lbs bond)

• 160 sheets of 60 g/m2 (16 lbs 
bond)

60 to 70 g/m2 (16 to 19 lbs bond)

• 1 sheet

Cotton
Refer to the Plain 
paper section 

Refer to the Plain paper section 75 to 90 g/m2 (20 to 24 lbs bond)

• 150 sheets of 80 g/m2 (21 lbs 
bond)

75 to 90 g/m2 (20 to 24 lbs bond)

• 1 sheet

Colored
Refer to the Plain 
paper section 

Refer to the Plain paper section 75 to 90 g/m2 (20 to 24 lbs bond)

• 150 sheets of 80 g/m2 (21 lbs 
bond)

75 to 90 g/m2 (20 to 24 lbs bond)

• 1 sheet

Pre-printed
Refer to the Plain 
paper section 

Refer to the Plain paper section 75 to 90 g/m2 (20 to 24 lbs bond)

• 150 sheets of 80 g/m2 (21 lbs 
bond)

75 to 90 g/m2 (20 to 24 lbs bond)

• 1 sheet

Recycled
Refer to the Plain 
paper section 

Refer to the Plain paper section 60 to 90 g/m2 (16 to 24 lbs bond)

• 150 sheets of 80 g/m2 (21 lbs 
bond)

60 to 90 g/m2 (16 to 24 lbs bond)

• 1 sheet

Type Size Dimensions
Print media weight/Capacitya

Tray Manual feeding in trayb
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Labelsc
Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lbs 
bond)

• 10 sheets

120 to 150 g/m2 (32 to 40 lbs bond)

• 1 sheet

Card stock

Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5,

Postcard 4x6

Refer to the Plain paper section 121 to 163 g/m2 (32 to 43 lbs 
bond)

• 10 sheets

121 to 163 g/m2 (32 to 43 lbs bond)

• 1 sheet

Bond paper
Refer to the Plain 
paper section 

Refer to the Plain paper section • 10 sheets • 1 sheet

Archive
Refer to the Plain 
paper section 

Refer to the Plain paper section • 100 sheets • 1 sheet

Minimum size (custom) 76 x 127 mm (3 x 5 inches) 60 to 163 g/m2 (16 to 43 lbs bond)

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)

a. Maximum capacity may differ depending on media weight, thickness, and environmental conditions. 
b. 1 sheet for manual feeding.
c. The smoothness of the labels used in this machine is 100 to 250 (sheffield). This means the numeric level of smoothness.

Type Size Dimensions
Print media weight/Capacitya

Tray Manual feeding in trayb
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System requirements

Microsoft® Windows®

 

 

Operating system
Requirement (recommended)

CPU RAM free HDD space

Windows® 2000 Intel® Pentium® II 400 MHz (Pentium III 933 MHz) 64 MB (128 MB) 600 MB

Windows® XP Intel® Pentium® III 933 MHz (Pentium IV 1 GHz) 128 MB (256 MB) 1.5 GB

Windows Server® 2003 Intel® Pentium® III 933 MHz (Pentium IV 1 GHz) 128 MB (512 MB) 1.25 GB to 2 GB

Windows Server® 2008 Intel® Pentium® IV 1 GHz (Pentium IV 2 GHz) 512 MB (2 GB) 10 GB

Windows Vista® Intel® Pentium® IV 3 GHz 512 MB (1 GB) 15 GB

Windows® 7 Intel® Pentium® IV 1 GHz 32-bit or 64-bit processor or higher 1 GB (2 GB) 16 GB

• Support for DirectX® 9 graphics with 128 MB memory (to enable the Aero theme).

• DVD-R/W Drive

Windows Server® 2008 R2 Intel® Pentium® IV 1 GHz (x86) or 1.4 GHz (x64) processors (2 GHz or faster) 512 MB (2 GB) 10 GB

Windows® 8 Intel® Pentium® IV 1 GHz 32-bit or 64-bit processor or higher 1 GB (2 GB) 16 GB
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• Internet Explorer 6.0 or higher is the minimum requirement for all Windows operating systems.

• Users who have administrator rights can install the software.

• Windows Terminal Services is compatible with your machine.

• For Windows 2000, Services Pack 4 or higher is required.

 

Mac

 

 

Operating system
Requirements (Recommended)

CPU RAM Free HDD space

Mac OS X 10.5 • Intel® processors

• 867 MHz or faster Power PC G4/G5

512 MB (1 GB) 1 GB

Mac OS X 10.6 • Intel® processors 1 GB (2 GB) 1 GB

Mac OS X 10.7 ~ 10.9 • Intel® processors 2 GB 4 GB
775. Appendix



Specifications

Linux

 

 

Items Requirements

Operating system Redhat® Enterprise Linux WS 4, 5, 6(32/64 bit)

Fedora 5 ~ 15 (32/64 bit)

OpenSuSE® 10.2, 10.3, 11.0, 11.1, 11.2, 11.3, 11.4 (32/64 bit)

Mandriva 2007, 2008, 2009, 2009.1, 2010 (32/64 bit)

Ubuntu 6.06, 6.10, 7.04, 7.10, 8.04, 8.10, 9.04, 9.10, 10.04, 10.10, 11.04 (32/64 bit)

SuSE Linux Enterprise Desktop 10, 11 (32/64 bit)

Debian 4.0, 5.0, 6.0 (32/64 bit)

CPU Pentium IV 2.4GHz (Intel Core™2)

RAM 512 MB (1 GB)

Free HDD space 1 GB (2 GB)
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Network environment

 

Network and wireless models only (see "Features by models" on page 7).

 

You need to set up the network protocols on the machine to use it as your network machine. The following table shows the network environments supported by the 
machine.

 

 

Items Specifications

Network interface • 802.11b/g/n Wireless LAN

Network operating system • Windows 2000/Server 2003 /Server 2008/XP/Vista/7/Server 2008 R2/8

• Various Linux OS

• Mac OS X 10.5 ~10.9

Network protocols • TCP/IPv4

• DHCP, BOOTP

• DNS, WINS, Bonjour, SLP, UPnP

• Standard TCP/IP Printing (RAW), LPR, IPP, WSD

• SNMPv 1/2/3, HTTP, IPSec

• TCP/IPv6 (DHCP, DNS, RAW, LPR, SNMPv 1/2/3, HTTP, IPSec)

Wireless security • Authentication: Open System, Shared Key, WPA Personal, WPA2 Personal (PSK)

• Encryption: WEP64, WEP128, TKIP, AES
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This machine is designed for a normal work environment and certified with 
several regulatory statements.

5 

Laser safety statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21 
CFR, chapter 1 Subchapter J for Class I(1) laser products, and elsewhere is 
certified as a Class I laser product conforming to the requirements of IEC 60825-
1:2007.

Class I laser products are not considered to be hazardous. The laser system and 
printer are designed so there is never any human access to laser radiation above 
a Class I level during normal operation, user maintenance or prescribed service 
condition.

Warning 

Never operate or service the printer with the protective cover removed from 
laser/scanner assembly. The reflected beam, although invisible, can damage 
your eyes.

When using this product, these basic safety precautions should always be 
followed to reduce risk of fire, electric shock, and injury to persons:
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6 

Ozone safety

7 

Mercury Safety

8 

Power saver

9 

Recycling

This product’s ozone emission rate is under 0.1 ppm. Because 
ozone is heavier than air, keep the product in a place with good 
ventilation.

Contains Mercury, Dispose According to Local, State or Federal 
Laws.(U.S.A. only)

This printer contains advanced energy conservation technology that 
reduces power consumption when it is not in active use.

When the printer does not receive data for an extended period of 
time, power consumption is automatically lowered. 

ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 

For more information on the ENERGY STAR program see http://
www.energystar.gov

For ENERGY STAR certified models, the ENRGY STAR label will be on 
your machine. Check if your machine is ENERGY STAR certified.

Recycle or dispose of the packaging material for this product in an 
environmentally responsible manner.
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China only

 website: www.dell.com/recycle

11 

Correct disposal of this product (Waste electrical & 
electronic equipment)

(Applicable in countries with separate collection 
systems)

Dan hab yungh youq gij digih haijbaz 2000 m doxroengz haenx ancienz sawjyungh.

2000m

This marking on the product, accessories or literature indicates that the 
product and its electronic accessories (e.g. charger, headset, USB cable) 
should not be disposed of with other household waste at the end of 
their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these 
items from other s of waste and recycle them responsibly to promote the 
sustainable reuse of material resources.

Household users should contact either the retailer where they 
purchased this product, or their local government office, for details of 
where and how they can take these items for environmentally safe 
recycling.

Business users should contact their supplier and check the terms and 
conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for 
disposal.
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(The United States of America only)

Dispose unwanted electronics through an approved recycler. To find the nearest 
recycling location, go to our website: www.dell.com/recyclingdirect Or call, 
(877) 278 - 0799

12 

State of California Proposition 65 Warning (US Only)

13 

Taiwan only

14 

Radio frequency emissions

FCC information to the user

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: 

• This device may not cause harmful interference, and

• This device must accept any interference received, including interference 
that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class 
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.
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• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the manufacturer 
responsible for compliance could void the user's authority to operate the 
equipment.

 

Canadian radio interference regulations

This digital apparatus does not exceed the Class B limits for radio noise 
emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and 
Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques 
applicables aux appareils numériques de Classe B prescrites dans la norme sur le 
matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et 
Sciences Canada.

15 

United States of America

Federal Communications Commission (FCC)

Intentional emitter per FCC Part 15

Low power, Radio LAN devices (radio frequency (RF) wireless communication 
devices), operating in the 2.4 GHz/5 GHz Band, may be present (embedded) in 
your printer system. This section is only applicable if these devices are present. 
Refer to the system label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in the 
United States of America if an FCC ID number is on the system label.

The FCC has set a general guideline of 20 cm (8 inches) separation between the 
device and the body, for use of a wireless device near the body (this does not 
include extremities). This device should be used more than 20 cm (8 inches) 
from the body when wireless devices are on. The power output of the wireless 
device (or devices), which may be embedded in your printer, is well below the 
RF exposure limits as set by the FCC.

This transmitter must not be collocated or operation in conjunction with any 
other antenna or transmitter.

Operation of this device is subject to the following two conditions: (1) This 
device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired 
operation of the device.
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Wireless devices are not user serviceable. Do not modify them in any way. 
Modification to a wireless device will void the authorization to use it. 
Contact manufacturer for service.

 

FCC Statement for Wireless LAN use:

 

While installing and operating this transmitter and antenna combination 
the radio frequency exposure limit of 1m W/cm2 may be exceeded at 
distances close to the antenna installed. Therefore, the user must maintain 
a minimum distance of 20cm from the antenna at all times. This device 
cannot be colocated with another transmitter and transmitting antenna.

 

16 

Russia only

17 

Germany only

18 

Turkey only
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Thailand only

20 

Canada only

This product meets the applicable Industry Canada technical specifications. / Le 
present materiel est conforme aux specifications techniques applicables 
d’Industrie Canada.

The Ringer Equivalence Number (REN) is an indication of the maximum number 
of devices allowed to be connected to a telephone interface. The termination of 
an interface may consist of any combination of devices subject only to the 
requirement that the sum of the RENs of all the devices not exceed five. / L’indice 
d’equivalence de la sonnerie (IES) sert a indiquer le nombre maximal de 
terminaux qui peuvent etre raccordes a une interface telephonique. La 
terminaison d’une interface peut consister en une combinaison quelconque de 
dispositifs, a la seule condition que la somme d’indices d’equivalence de la 
sonnerie de tous les dispositifs n’excede pas cinq.

21 

Ringer Equivalence Number

The Ringer Equivalence Number and FCC Registration Number for this machine 
may be found on the label located on the bottom or rear of the machine. In some 
instances you may need to provide these numbers to the telephone company.

The Ringer Equivalence Number (REN) is a measure of the electrical load placed 
on the telephone line, and is useful for determining whether you have 
“overloaded” the line. Installing several s of equipment on the same telephone 
line may result in problems making and receiving telephone calls, especially 
ringing when your line is called. The sum of all Ringer Equivalence Numbers of 
the equipment on your telephone line should be less than five in order to assure 
proper service from the telephone company. In some cases, a sum of five may 
not be usable on your line. If any of your telephone equipment is not operating 
properly, you should immediately remove it from your telephone line, as it may 
cause harm to the telephone network.

The equipment complies with Part 68 of the FCC rules and the requirements 
adopted by the ACTA. On the rear of this equipment is a label that contains, 
among other information, a product identifier in the format US:AAAEQ##TXXXX. 
If requested, this number must be provided to the telephone company.
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FCC Regulations state that changes or modifications to this equipment not 
expressly approved by the manufacturer could void the user’s authority to 
operate this equipment. In the event that terminal equipment causes harm 
to the telephone network, the telephone company should notify the 
customer that service may be stopped. However, where prior notice is 
impractical, the company may temporarily cease service, providing that 
they:

a promptly notify the customer.
b give the customer an opportunity to correct the equipment problem.
c inform the customer of the right to bring a complaint to the Federal 

Communication Commission pursuant to procedures set out in FCC 
Rules and Regulations Subpart E of Part 68.

 

You should also know that:

• Your machine is not designed to be connected to a digital PBX system.

• If you intend to use a computer modem or fax modem on the same phone 
line as your machine, you may experience transmission and reception 
problems with all the equipment. It is recommended that no other 
equipment, except for a regular telephone, share the line with your 
machine.

• If your area experiences a high incidence of lightning or power surges, we 
recommend that you install surge protectors for both the power and the 
telephone lines. Surge protectors can be purchased from your dealer or 
telephone and electronic specialty stores.

• When programming emergency numbers and/or making test calls to 
emergency numbers, use a non-emergency number to advise the 
emergency service dispatcher of your intentions. The dispatcher will give 
you further instructions on how to actually test the emergency number.

• This machine may not be used on coin service or party lines.

• This machine provides magnetic coupling to hearing aids.

You may safely connect this equipment to the telephone network by means of 
a standard modular jack, USOC RJ-11C.

22 

Replacing the Fitted Plug (for UK Only)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug 
and has a 13 amp fuse. When you change or examine the fuse, you must re-fit 
the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost 
the fuse cover, do not use the plug until you have another fuse cover. 

Contact the people from you purchased the machine.

The 13 amp plug is the most widely used in the UK and should be suitable. 
However, some buildings (mainly old ones) do not have normal 13 amp plug 
sockets. You need to buy a suitable plug adaptor. Do not remove the moulded 
plug.
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If you cut off the moulded plug, get rid of it straight away.You cannot rewire 
the plug and you may receive an electric shock if you plug it into a socket.

 

Important warning: 

If the wires in the mains lead do not match the colors marked in your plug, do 
the following:

You must connect the green and yellow wire to the pin marked by the letter “E” 
or by the safety ‘Earth symbol’ or colored green and yellow or green.

You must connect the blue wire to the pin which is marked with the letter “N” or 
colored black.

You must connect the brown wire to the pin which is marked with the letter “L” 
or colored red.

You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

23 

Declaration of conformity (European countries)

Approvals and Certifications

January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of 
the member states related to low voltage equipment.

January 1, 1996: Council Directive 2004/108/EC, approximation of the laws of 
the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual recognition of their 
conformity. A full declaration, defining the relevant Directives and referenced 
standards can be obtained from your Dell Inc. representative.

You must earth this machine.

The wires in the mains lead have the following color code:

• Green and Yellow: Earth

• Blue: Neutral

• Brown: Live

Hereby, Dell Inc. declares that this [B1163 Series] is in compliance 
with the essential requirements and other relevant provisions of Low 
Voltage Directive (2006/95/EC), EMC Directive (2004/108/EC).

Hereby, Dell Inc. declares that this [B1163 Series] is in compliance 
with the essential requirements and other relevant provisions of 
R&TTE Directive 1999/5/EC.

The declaration of conformity may be consulted at www.dell.com, 
go to Support > Download center and enter your printer (MFP) name 
to browse the EuDoC. 
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EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal 
Equipment Directive (FAX)

This Dell product has been self-certified by Dell for pan-European single 
terminal connection to the analogue public switched telephone network (PSTN) 
in accordance with Directive 1999/5/EC. The product has been designed to work 
with the national PSTNs and compatible PBXs of the European countries:

In the event of problems, you should contact the Euro QA Lab of Dell Inc. in the 
first instance.

The product has been tested against TBR21. To assist in the use and application 
of terminal equipment which complies with this standard, the European 
Telecommunication Standards Institute (ETSI) has issued an advisory document 
(EG 201 121) which contains notes and additional requirements to ensure 
network compatibility of TBR21 terminals. The product has been designed 
against, and is fully compliant with, all of the relevant advisory notes contained 
in this document.

European radio approval information (for products 
fitted with EU-approved radio devices)

Low power, Radio LAN type devices (radio frequency (RF) wireless 
communication devices), operating in the 2.4 GHz/5 GHz band, may be present 
(embedded) in your printer system which is intended for home or office use. This 
section is only applicable if these devices are present. Refer to the system label 
to verify the presence of wireless devices.

The power output of the wireless device or devices that may be embedded in 
you printer is well below the RF exposure limits as set by the European 
Commission through the R&TTE directive.

European states qualified under wireless approvals:

EU countries

European states with restrictions on use:

EU

In France, the frequency range is restricted to 2454-2483.5 MHz for devices 
above 10 mW transmitting power such as wireless

EEA/EFTA countries

No limitations at this time

Wireless devices that may be in your system are only qualified for 
use in the European Union or associated areas if a CE mark with a 
Notified Body Registration Number and the Alert Symbol is on the 
system label.
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Israel only

25 

Regulatory compliance statements

Wireless guidance

Low power, Radio LAN devices (radio frequency (RF) wireless communication 
devices), operating in the 2.4 GHz/5 GHz Band, may be present (embedded) in 
your printer system. The following section is a general overview of 
considerations while operating a wireless device.

Additional limitations, cautions, and concerns for specific countries are listed in 
the specific country sections (or country group sections). The wireless devices in 
your system are only qualified for use in the countries identified by the Radio 
Approval Marks on the system rating label. If the country you will be using the 
wireless device in, is not listed, contact your local Radio Approval agency for 
requirements. Wireless devices are closely regulated and use may not be 
allowed.

The power output of the wireless device or devices that may be embedded in 
your printer is well below the RF exposure limits as known at this time. Because 
the wireless devices (which may be embedded into your printer) emit less 
energy than is allowed in radio frequency safety standards and 
recommendations, manufacturer believes these devices are safe for use. 
Regardless of the power levels, care should be taken to minimize human contact 
during normal operation.

As a general guideline, a separation of 20 cm (8 inches) between the wireless 
device and the body, for use of a wireless device near the body (this does not 
include extremities) is typical. This device should be used more than 20 cm (8 
inches) from the body when wireless devices are on and transmitting.

This transmitter must not be collocated or operation in conjunction with any 
other antenna or transmitter.

Some circumstances require restrictions on wireless devices. Examples of 
common restrictions are listed below:

Radio frequency wireless communication can interfere with 
equipment on commercial aircraft. Current aviation regulations 
require wireless devices to be turned off while traveling in an airplane. 
IEEE 802.11 (also known as wireless Ethernet) and Bluetooth 
communication devices are examples of devices that provide wireless 
communication.
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In environments where the risk of interference to other devices or 
services is harmful or perceived as harmful, the option to use a wireless 
device may be restricted or eliminated. Airports, Hospitals, and 
Oxygen or flammable gas laden atmospheres are limited examples 
where use of wireless devices may be restricted or eliminated. When in 
environments where you are uncertain of the sanction to use wireless 
devices, ask the applicable authority for authorization prior to use or 
turning on the wireless device.

Every country has different restrictions on the use of wireless devices. 
Since your system is equipped with a wireless device, when traveling 
between countries with your system, check with the local Radio 
Approval authorities prior to any move or trip for any restrictions on 
the use of a wireless device in the destination country.

If your system came equipped with an internal embedded wireless 
device, do not operate the wireless device unless all covers and shields 
are in place and the system is fully assembled.

Wireless devices are not user serviceable. Do not modify them in any 
way. Modification to a wireless device will void the authorization to 
use it. Contact manufacturer for service.

Only use drivers approved for the country in which the device will be 
used. See the manufacturer System Restoration Kit, or contact 
manufacturer Technical Support for additional information.
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China only
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Copyright

Information in this document is subject to change without notice.

©2013 Dell Inc. All rights reserved.

Reproduction of these materials in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell, the Dell logo, and Dell Toner Management System are trademarks of Dell Inc.; Microsoft, Windows, Windows Vista, Windows Server , 
Windows 7, and Windows 8 are registered trademarks of Microsoft Corporation in the United States and/or other countries; Adobe and Acrobat Reader are either 
registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. 

iPad, iPhone, iPod touch, TrueType, Mac and Mac OS are trademarks of Apple Inc., registered in the U.S and other countries. AirPrint and the AirPrint logo are 
trademarks of Apple Inc.

Other trademarks and trade names may be used in this document to refer to the entities claiming the marks and names of their products. 

Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own.

Google Cloud Print is a trademark of Google Inc.

Google, Picasa, Google Docs, Android and Gmail are either registered trademarks or trademarks of Google Inc.

Refer to the 'LICENSE.txt' file in the provided CD/DVD for the open source license information.

REV. 2.00
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This guide provides information about installation, advanced configur
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ation, 
operation and troubleshooting on various OS environments. 
Some features may not be available depending on models or countries.
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1. Software Installation
This chapter provides instructions for installing essential and helpful software for use in an environment where the 
machine is connected via a cable. A locally connected machine is a machine directly attached to your computer using 
the cable.
• Installation for Mac 97
• Reinstallation for Mac 98
• Installation for Linux 99
• Reinstallation for Linux 100
 

• If you are a Windows OS user, refer to the Basic Guide for installing the machine’s driver (see 
"Installing the driver locally" on page 22).

• Only use a USB cable no longer then 3 meter (118 inches).

 



Installation for Mac

1 Make sure that the machine is connected to your computer and 

powered on.

2 Insert the supplied software CD into your CD/DVD drive.

3 Double-click the CD/DVD icon that appears on your Mac desktop.

• For Mac OS X 10.8, double-click the CD/DVD that appears on Finder.

4 Double-click the MAC_Installer folder > Installer OS X icon.

5 Click Continue.

6 Read the license agreement and click Continue.

7 Click Agree to agree to the license agreement.

8 Click Install. All components necessary for machine operations will be 
installed.

If you click Customize, you can choose individual components to install.

9 Enter the password and click OK.

10 Select USB Connected Printer on the Printer Connection Type and 
click Continue.

11 Click Add Printer button to select your printer and add it to your printer 
list.

12 After the installation is finished, click Close or Restart.
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Reinstallation for Mac

If the printer driver does not work properly, uninstall the driver and reinstall it.

1 Open the Applications folder > Dell > Printer Software Uninstaller.

2 To uninstall printer software, click Continue.

3 Check the program you want to delete and click Uninstall.

4 Enter the password and click OK.

5 After the uninstallation is finished, click Close.

 

If a machine has already been added, delete it from the Print Setup Utility 
or Print & Fax.
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Installation for Linux

You need to download Linux software packages from the Dell website to install 
the printer software (http://www.dell.com/support).

1 

Installing the Unified Linux Driver

1 Make sure that the machine is connected to your computer and 
powered on.

2 When the Administrator Login window appears, type “root” in the 
Login field and enter the system password.

 

You must log in as a super user (root) to install the machine software. If you 
are not a super user, ask your system administrator.

 

3 From the Dell website, download the Unified Linux Driver package to 
your computer.

4 Right-click the Unified Linux Driver package and extract the package. 

5 Double click cdroot > autorun.

6 When the welcome screen appears, click Next.

7 When the installation is complete, click Finish.

The installation program added the Unified Driver Configurator desktop icon 
and the Unified Driver group to the system menu for your convenience. If you 
have any difficulties, consult the on-screen help that is available through your 
system menu or from the driver package Windows applications, such as Unified 
Driver Configurator or Image Manager.
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Reinstallation for Linux

If the printer driver does not work properly, uninstall the driver and reinstall it. 

1 Make sure that the machine is connected to your computer and 
powered on.

2 When the Administrator Login window appears, type “root” in the 
Login field and enter the system password.

You must log in as a super user (root) to uninstall the printer driver. If you 
are not a super user, ask your system administrator.

3 Open Terminal program. When the Terminal screen appears, type in the 
following.

[root@localhost root]#cd /opt/DELL/mfp/uninstall/[root@localhost 
uninstall]#./uninstall.sh

4 Click Next. 

5 Click Finish.
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2. Using a Network-
Connected Machine

This chapter gives you step-by-step instructions for setting up a network connected machine and software.
• Useful network programs 102
• AirPrint 103
• Google Cloud Print™ 105
• Wireless network setup 108
 

Supported optional devices and features may differ according to your model (see "Features by 
models" on page 7).

 



Useful network programs

There are several programs available to setup the network settings easily in a 
network environment. For the network administrator especially, managing 
several machines on the network is possible. 

 

• Before using the programs below, set the IP address first. 

• Some features and optional goods may not be available depending on 
model or country (see "Features by models" on page 7).
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B1163w only

 

1 

Setting up AirPrint

Bonjour(mDNS) and IPP protocols are required on your machine to use the 
AirPrint feature. You can enable the AirPrint feature by one of the following 
methods.

1 Check whether the machine is connected to the network.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login in the upper right of the Embedded Web Service website.

4 Type in the ID and Password, then click Login. If it’s your first time 
logging into Embedded Web Service, type in the below default ID and 
password. We recommend you to change the default password for 
security reasons.

• ID: admin

• Password: dell00000 

5 When the Embedded Web Service window opens, click Settings > 
Network Settings.

6 Click Raw TCP/IP, LPR, IPP or mDNS .

You can enable the IPP protocol or mDNS protocol.

AirPrint allows you to wirelessly print directly from an iPhone, iPad, or 
iPod touch running iOS 4.2 or later.
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AirPrint

2 

Printing via AirPrint

For example, the iPad manual provides these instructions:

1 Open your email, photo, web page, or document you want to print.

2 Touch the action icon( ).

3 Select your printer driver name and option menu to set up.

4 Touch Print button. Print it out.

 

Cancelling print job: To cancel the printing job or view the print summary, 

click the print center icon ( ) in multitasking area. You can click cancel in 

the print center.
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Google Cloud Print™

Google Cloud Print™ is a service that allows you to print to a printer using your 

smart phone, tablet, or any other web-connected devices. Just register your 
Google account with the printer, and you are ready to use the Google Cloud 
Print™ service. You can print your document or email with Chrome OS, Chrome 
browser, or a Gmail™/ Google Docs™ application on your mobile device, so you 

don’t need to install the printer driver on the mobile device. Refer to the Google 
website (http://support.google.com/cloudprint) for more information about 
Google Cloud Print™.

3 

Registering your Google account to the printer

 

• Make sure the printer machine is turned on and connected to a wired or 
wireless network that has access to the Internet. 

• You should create your Google account in the advance. 

 

1 Open the Chrome browser.

2 Visit www.google.com.

3 Sign in to the Google website with your Gmail™ address.

4 Enter your printer’s IP address in the address field and press the Enter key 
or click Go.

5 Click Login in the upper right corner of the Embedded Web Service 
website.

6 If it’s your first time logging into Embedded Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: dell00000 

 

If the network environment is using a proxy server, you need to configure 
the proxy’s IP and port number from Settings > Network Settings > 
Google Cloud Print > Proxy Setting. Contact your network service 
provider or network administrator for more information. 

 

7 When the Embedded Web Service window opens, click Settings > 
Network Settings > Google Cloud Print.

8 Enter your printer’s name and description.

9 Click Register.

The confirmation pop-up window appears.

 

If you set the browser to block pop-ups, the confirmation window will not 
appear. Allow the site to show pop-ups. 
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Google Cloud Print™

10 Click Finish printer registration.

11 Click Manage your printers.

Now your printer is registered with Google Cloud Print™ service.

Google Cloud Print™-ready devices will appear in the list.

4 

Printing with Google Cloud Print™

The printing procedure varies depending on the application or the device you 

are using. You can see the application list that supports Google Cloud Print™ 
service.

 

Make sure the printer is turned on and connected to a wired or wireless 
network that has access to the Internet. 

 

To share your printer with your freinds, please refer to the following web site. 
http://support.google.com/chromeos/bin/answer.py?hlen&answer1241064

Printing from an application on mobile device

The following steps are an example of using the Google Docs™ app from 
Android mobile phone.

1 Install the Cloud Print application on your mobile device. 

 

If you do not have the application, download it from the application store 

such as Android Market or App Store. 

 

1062.  Using a Network-Connected Machine



Google Cloud Print™

2 Access the Google Docs™ application from your mobile device and tap

on the icon to select document.

3 Tap the option  button of the document that you want to print.

4 Tap the send  button.

5 Tap the Cloud Print  button.

6 Set the printing options if you want.

7 Tap Click here to Print.

Printing from the Chrome browser

The following steps are an example of using the Chrome browser.

1 Run Chrome.

2 Open the document or email that you want to print.

3 Click the wrench icon  in the browser’s top right corner.

4 Click Print. A new tab for printing appears.

5 Select Print with Google Cloud Print.

6 Click the Print button.
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Wireless network setup

 

• Make sure your machine supports wireless networking. Wireless 
networking may not be available depending on the model (see "Features 
by models" on page 7).

 

5 

Getting started

Understanding your network type

Typically, you can only have one connection between your computer and the 
machine at a time.

Wireless network name and network password

Wireless networks require higher security, so when an access point is first set up, 
a network name (SSID), the type of security used, and a Network Password are 
created for the network. Ask your network administrator about this information 
before proceeding with the machine installation.

Infrastructure mode

This is an environment generally used for homes and SOHOs 
(Small Office/ Home Office). This mode uses an access point to 
communicate with the wireless machine.

Ad hoc mode

This mode does not use an access point. The wireless 
computer and wireless machine communicate directly. 
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6 

Introducing wireless set up methods

You can set wireless settings either from the machine or the computer. Choose the setting method from the below table.

 

Some wireless network installation types may not be available depending on the model or country.

 

 

 

 

• If problems occur during wireless set up or driver installation, refer to the troubleshooting chapter (see "Troubleshooting" on page 130).

• It is strongly recommended that you set the password on Access Points. If you do not set the password on Access Points, they might be exposed to illegal access 
from unknown machines including PCs, smart phones and printers. Refer to the Access Point user' guide for password settings.

 

Set up method Connecting method Description & Reference

With Access Point 

From the computer Windows User, see "Dell Printer Easy Wi-Fi Install" on page 114.

Windows User, see "Access point via USB cable in Windows" on page 117.

Mac User, see "Access point via USB cable" on page 123.

From the machine’s control panel See "Using the WPS button" on page 110.

Without Access Point 
From the computer Windows User, see "Ad hoc via USB cable" on page 125.

Mac User, see "Ad hoc via USB cable" on page 125.
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7 

Using the WPS button 

If your machine and an access point (or wireless router) support Wi-Fi Protected 
Setup™ (WPS), you can easily configure the wireless network settings by 

pressing the  (WPS) button on the control panel without a computer.

 

• If you want to use the wireless network using the infrastructure mode, 
make sure that the network cable is disconnected from the machine. 
Using the WPS (PBC) button or entering the PIN from the computer to 
connect to the access point (or wireless router) varies depending on the 
access point (or wireless router) you are using. Refer to the user's guide 
of the access point (or wireless router) you are using.

• When using the WPS button to set the wireless network, security settings 
may change. To prevent this, lock the WPS option for the current wireless 
security settings. The option name may differ depending on the access 
point (or wireless router) you are using.

 

Items to prepare

• Check if the access point (or wireless router) supports Wi-Fi Protected 
Setup™ (WPS).

• Check if your machine supports Wi-Fi Protected Setup™ (WPS).

• Networked computer (PIN mode only)

Choosing your type

There are two methods available to connect your machine to a wireless network 

using the  (WPS) button on the control panel.

The Push Button Configuration (PBC) method allows you to connect your 

machine to a wireless network by pressing both the  (WPS) button on the 
control panel of your machine and the WPS (PBC) button on a Wi-Fi Protected 
Setup™ WPS-enabled access point (or wireless router) respectively.

The Personal Identification Number (PIN) method helps you connect your 
machine to a wireless network by entering the supplied PIN information on a Wi-
Fi Protected Setup™ WPS-enabled access point (or wireless router).

Factory default in your machine is PBC mode, which is recommended for a 
typical wireless network environment.
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Machines with a display screen

Connecting in PBC mode

1 Press and hold the  (WPS) button on the control panel for more than 
2 seconds.

The machine starts waiting for up to two minutes until you press the WPS 
(PBC) button on the access point (or wireless router).

2 Press the WPS (PBC) button on the access point (or wireless router).

The messages are displayed on the display screen in the order below:

a Connecting: The machine is connecting to the access point (or 
wireless router).

b Connected: When the machine is successfully connected to the 
wireless network, the WPS LED light stays on.

c AP SSID: After completing the wireless network connection process, 
the AP’s SSID information appears on the display.

3 Insert the supplied CD into the CD/DVD drive and proceed to install the 
software following the directions on the screen. When the "Connect 
Printer" screen appears, select the Network (Ethernet/Wireless) 
connection.

Connecting in PIN mode

1 Press and hold the  (WPS) button on the control panel for more than 
2 seconds.

2 The eight-digit PIN appears on the display. 

You need to enter the eight-digit PIN within two minutes on the 
computer that is connected to the access point (or wireless router).

The messages are displayed on the display screen in the order below:

a Connecting: The machine is connecting to the wireless network.

b Connected: When the machine is successfully connected to the 
wireless network, the WPS LED light stays on.

c SSID Type: After completing the wireless network connection 
process, the AP’s SSID information is displayed on the LCD display.

3 Insert the supplied CD into the CD/DVD drive and proceed to install the 
software following the directions on the screen. When the "Connect 
Printer" screen appears, select Network (Ethernet/Wireless) connection.
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Machines without a display screen

Connecting in PBC mode

1 Press and hold the  (WPS) button on the control panel for about 2 - 4 
seconds until the status LED blinks quickly.

The machine starts connecting to the wireless network. The LED blinks 
slowly for up to two minutes until you press the PBC button on the 
access point (or wireless router).

2 Press the WPS (PBC) button on the access point (or wireless router).

a The light blinks fast on the WPS LED. The machine is connecting to 
the access point (or wireless router). 

b When the machine is successfully connected to the wireless 
network, the WPS LED light stays on.

3 Insert the supplied CD into the CD/DVD drive and proceed to install the 
software following the directions on the screen. When the "Connect 
Printer" screen appears, select the Network (Ethernet/Wireless) 
connection.

Connecting in PIN mode

1 The network configuration report, including PIN, must be printed.

In ready mode, press and hold the  (Cancel or Stop/Clear) button on 
the control panel for about 5 seconds. You can find your machine’s PIN.

2 Press and hold the  (WPS) button on the control panel for more than 
4 seconds until the status LED stays on.

The machine starts connecting to the access point (or wireless router).

3 You need to enter the eight-digit PIN within two minutes on the 
computer that is connected to the access point (or wireless router).

The LED blinks slowly for up to two minutes until you enter the eight-
digit PIN.

The WPS LED blinks in the order below:

a The light blinks fast on the WPS LED. The machine is connecting to 
the access point (or wireless router).

b When the machine is successfully connected to the wireless 
network, the WPS LED light stays on.

4 Insert the supplied CD into the CD/DVD drive and proceed to install the 
software following the directions on the screen. When the "Connect 
Printer" screen appears, select the Network (Ethernet/Wireless) 
connection.
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Re-connecting to a network

When the wireless function is off, the machine automatically tries to re-connect 
to the access point (or wireless router) with the previously used wireless 
connection settings and address.

 

In the following cases, the machine automatically re-connects to the 
wireless network:

• The machine is turned off and on again.

• The access point (or wireless router) is turned off and on again.

 

Canceling the connection process

To cancel the wireless network connection when the machine is connecting to 

the wireless network, press and release the  (Cancel or Stop/Clear) on the 
control panel. You need to wait 2 minutes to re-connect to the wireless 
network.

Disconnecting from a network

To disconnect the wireless network connection, press the  (WPS) button on 
the control panel for more than two seconds.

• When the Wi-Fi network is in idle mode: The machine is immediately 
disconnected from the wireless network and the WPS LED turns off.

• When the Wi-Fi network is being used: While the machine waits until the 
current job is finished, the light blinks fast on the WPS LED. Then, the 
wireless network connection is automatically disconnected and the WPS 
LED turns off.
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8 

Setup using Windows

Dell Printer Easy Wi-Fi Install

Before Using Dell Printer Easy Wi-Fi Install, please ensure that OS of your 
computer should be Windows 7 and above.

• Items to prepare

- Access point

- Wireless network-connected computer

- Software CD that was provided with your machine

 

If any of the following conditions occur, you can not use Dell Printer Easy 
Wi-Fi Install. In that case, see "Access point via USB cable" on page 123 or 
"Ad hoc via USB cable" on page 125 .

- OS of your computer is Windows Vista or earlier.

- Your PC does not support wireless network.

- Your PC can not connect to wireless network.

 

1 Turn on your computer, access point and machine.

2 Connect your computer to the wireless network.

3 Insert the supplied software CD into your CD/DVD drive.

The software CD should automatically run and an installation window 
will appear.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

X:\Setup.exe replacing “X” with the letter, which represents your CD/
DVD drive and click OK.

• For Windows 8,

If the installation window does not appear, from Charms, select 
Search > Apps and search for Run. Type in X:\Setup.exe, replacing 
“X” with the letter that represents your CD/DVD drive and click OK.

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

4 Click New Printer.
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5 Select Wireless and click Next.

6 Setup searches for printers.

 

If the search has failed, a Connecting the Device window will be appeared. 
(see "Click Next." on page 118)

 

7 Set your printer name and click Next.
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8 Setup is installing printer software. 9 After the installation is finished, a window asking you to print a test page 

appears. If you want to print a test page, click Print a test page.

Otherwise, just click Next and go to step 10.

10 Click Finish.
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Access point via USB cable in Windows

If you can not use Dell Printer Easy Wi-Fi Install, you may still connect the 
machine wirelessly to your computer using USB cable by following steps below.

• Items to prepare

- Access point

- Network-connected computer

- Software CD that was provided with your machine

- The machine installed with a wireless network interface

- USB cable

 

If any of the following conditions occur, you have to setup Wi-Fi installation 
using a USB cable.

- OS of your computer is Windows Vista or earlier.

- Your PC does not support wireless network.

- Your PC can not connect to wireless network.

 

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer, access point, and machine.

 

If the “Found New Hardware Wizard” appears during the installation 
procedure, click Cancel to close the window.

 

3 Insert the supplied software CD into your CD/DVD drive.

The software CD should automatically run and an installation window 
will appear.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

X:\Setup.exe replacing “X” with the letter, which represents your CD/
DVD drive and click OK.

• For Windows 8,

a If the installation window does not appear, from Charms, select 
Search > Apps and search for Run. 

b Type in X:\Setup.exe, replacing “X” with the letter that represents 
your CD/DVD drive and click OK.

c If “Tap to choose what happens with this disc.” pop-up 
window appears, click the window and select Run Setup.exe.
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4 Click New Printer .

5 Choose Wireless.

6 Click Next.

7 The Setup searches the wireless network.

 

If the search has failed, you may check if the USB cable is properly connected 
between the computer and machine, and follow the instructions on the 
window.
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8 After searching, the window shows the wireless network devices. Select 

the name (SSID) of the access point you are using and click Next.

 

If you cannot find the network name you want to choose, or if you want to 

set the wireless configuration manually, click  (Plus) button.

• Enter the wireless Network Name: Enter the SSID of access point you 
want (SSID is case-sensitive).

• Operation Mode: Select Infrastructure.

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.
WPA Personal or WPA2 Personal: Select this option to authenticate the 
print server based on WPA Pre-Shared Key. This uses a shared secret key 
(generally called Pre- Shared Key pass phrase) which is manually 
configured on the access point and each of its clients.

• Encryption: Select the encryption (None, WEP64, WEP128, TKIP, AES, 
TKIP AES).

• Network Key: Enter the encryption network key value.

• Confirm Network Key: Confirm the encryption network key value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

 

 

The wireless network security window appears when the access point has 
security settings.

The wireless network security window appears. The window may differ 
according to its security mode: WEP, or WPA.

• WEP
Select Open System or Shared Key for the authentication and enter the 
WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol preventing 
unauthorized access to your wireless network. WEP encrypts the data 
portion of each packet exchanged on a wireless network using a 64-bit 
or 128-bit WEP encryption key.

• WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key that changes 
automatically at regular intervals. WPA also uses TKIP (Temporal Key 
Integrity Protocol) and AES (Advanced Encryption Standard) for data 
encryption.
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9 When the wireless network setting is completed, disconnect the USB 

cable between the computer and machine. Click Next.

10 Click Next when the Install Printer Driver window appear.

11 After the installation is finished, a window asking you to print a test page 
appears. If you want to print a test page, click Print a test page.

Otherwise, just click Next and go to step 16.

12 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

13 Click Finish.

Ad hoc via USB cable in Windows

If you do not use an access point (AP), you may still connect the machine 
wirelessly to your computer by setting up an ad-hoc wireless network by 
following the simple steps below.

• Items to prepare

- Network-connected computer

- Software CD that was provided with your machine

- The machine installed with a wireless network interface

- USB cable

 

If any of the following conditions occur, you have to setup Wi-Fi installation 
using a USB cable.

- OS of your computer is Windows Vista or earlier.

- Your PC does not support wireless network.

- Your PC can not connect to wireless network.

 

1 Check whether the USB cable is connected to the machine.

2 Turn on your computer and the wireless network machine.

3 Insert the supplied software CD into your CD/DVD drive.

The software CD should automatically run and an installation window 
will appear.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

X:\Setup.exe replacing “X” with the letter, which represents your CD/
DVD drive and click OK.
1202.  Using a Network-Connected Machine



Wireless network setup

4 Select New Printer.

5 Select Wireless.

6 The software searches the wireless network.

 

If the software has failed to search the network, check if the USB cable is 
connected properly between the computer and machine, and follow the 
instruction in the window.

 

7 After searching the wireless networks, a list of wireless networks your 
machine has searched appears.

Then, click  (Plus) button.

8 The window showing the wireless network setting appears. Check the 
settings and click Next.

 

• Enter the wireless Network Name: Enter the SSID name you want (SSID 
is case-sensitive).

• Operation Mode: Select ad hoc.

• Channel: Select the channel. (Auto Setting or 2412 MHz to 2467 MHz).

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.

• Encryption: Select the encryption (None, WEP64, WEP128).

• Network Key: Enter the encryption network key value.
1212.  Using a Network-Connected Machine



Wireless network setup

• Confirm Network Key: Confirm the encryption network key value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

The wireless network security window appears when the ad hoc network 
has security setting.

The wireless network security window appears. Select Open System or 
Shared Key for the authentication and click Next.

• WEP (Wired Equivalent Privacy) is a security protocol preventing 
unauthorized access to your wireless network. WEP encrypts the data 
portion of each packet exchanged on a wireless network using a 64-bit 
or 128-bit WEP encryption key.

 

9 The Confirm Wireless Network Settings window appears. Click the 
settings and click Next.

 

If you want to change TCP/IP settings, click Change TCP/IP

Before entering the IP address for the machine, you must know the 
computer’s network configuration information. If the computer’s network 
configuration is set to DHCP, the wireless network setting should also be 
DHCP. Likewise, if the computer’s network configuration is set to Static, the 
wireless network setting should also be Static.

If your computer is set to DHCP and you want to use the Static wireless 
network setting, you must contact the network administrator to get the 
static IP address.

• Receive IP address automatically (DHCP)
If the IP address assignment method is DHCP, check if DHCP is shown in 
the Confirm Wireless Network Settings window. If it shows Static, click 
Change TCP/IP to change the assignment method to Receive IP 
address automatically (DHCP).

• Use static address
If the IP address assignment method is Static, check if Static is shown in 
the Confirm Wireless Network Settings window. If it shows DHCP, click 
Change TCP/IP to enter the IP address and other network configuration 
values for the machine.
For example:
If the computer’s network information is as shown follows:

- IP address: 169.254.133.42

- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as below:

- IP address: 169.254.133.43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)

- Gateway: 169.254.133.1
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10 When the wireless network settings are completed, disconnect the USB 

cable between the computer and machine. Click Next.

11 Click Next when the Install Printer Driver window appears.

12 Select the components to be installed. Click Next.

13 After selecting the components, you can also change the machine name, 
set the machine to be shared on the network, set the machine as the 
default machine, and change the port name of each machine. Click Next.

14 After the installation is finished, a window asking you to print a test page 
appears. If you want to print a test page, click Print a test page.

Otherwise, just click Next and go to step 16.

15 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

16 Click Finish.

9 

Setup using Mac

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• USB cable

Access point via USB cable

1 Connect your machine to the network with a network cable.

2 Insert the supplied software CD into your CD/DVD drive.

3 Double-click the CD/DVD icon that appears on your Mac desktop.

• For Mac OS X 10.8, Double-click the CD/DVD icon that appears on 
your Finder.

4 Double-click the MAC_Installer folder > Installer OS X icon.

5 Click Continue.
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6 Read the license agreement and click Continue.

7 Click Agree to agree to the license agreement.

8 Click Install. All components necessary for machine operations will be 
installed.

If you click Customize, you can choose individual components to install.

9 Enter the password and click OK.

10 Select Configuration of Wireless network on the Printer Connection 
Type and click Continue.

11 After searching, the window shows the wireless network devices. Select 
the name (SSID) of the access point you are using and click Next.

 

When you set the wireless configuration manually, click Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of the access point 
(SSID is case-sensitive).

• Operation Mode: Select Infrastructure.

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.
WPA Personal or WPA2 Personal: Select this option to authenticate the 
print server based on the WPA Pre-Shared Key. This uses a shared secret 
key (generally called Pre Shared Key pass phrase) that is manually 
configured on the access point and each of its clients.

• Encryption: Select the encryption. (None, WEP64, WEP128, TKIP, AES, 
TKIP, AES)

• Network Password: Enter the encryption Network Password value.

• Confirm Network Password: Confirm the encryption Network 
Password value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

The wireless network security window appears when the access point has 
security enabled.

 

 

• You can start to build Wi-Fi Direct by using Dell Printer Manager (see 
"Setting up Wi-Fi Direct" on page 128).

• Network Name(SSID): The default Network Name is the model name 
and the maximum length is 22 characters (not including "Direct-xx-").

• Network Password is the numeric string, and the size is 8 ~ 64 
characters.

 

12 When the wireless network settings are completed, disconnect the USB 
cable between the computer and machine.

13 Wireless network set up is completed. After the installation is finished, 
click Quit.
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After completing the wireless network connection, you need to install a 
machine driver to print from an application (see "Installation for Mac" on 
page 97).

 

Ad hoc via USB cable

If you do not have an access point (AP), you may still connect the machine 
wirelessly to your computer by setting up an ad hoc wireless network by 
following these simple directions.

Items to prepare

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• USB cable

Creating the ad hoc network in Mac

1 Make sure that the machine is connected to your network and powered 
on.

2 Insert the supplied software CD into your CD/DVD drive.

3 Double-click the CD/DVD icon that appears on your Mac desktop.

• For Mac OS X 10.8, Double-click the CD/DVD icon that appears on 
your Finder.

4 Double-click the MAC_Installer folder > Installer OS X icon.

5 Click Continue.

6 Read the license agreement and click Continue.

7 Click Agree to agree to the license agreement.

8 Click Install. All components necessary for machine operations will be 
installed.

If you click Customize, you can choose individual components to install.

9 Enter the password and click OK.

10 Select Wireless connection on the Printer Connection Type and click 
Continue.

11 After searching the wireless networks, a list of wireless networks your 
machine has searched appears. Click the Advanced Settings button.
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• Enter the wireless Network Name: Enter the SSID name (SSID is case-
sensitive).

• Operation Mode: Select ad hoc.

• Channel: Select the channel (Auto Setting or 2412 MHz to 2467 MHz).

• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.
Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.

• Encryption: Select the encryption (None, WEP64, WEP128).

• Network Password: Enter the encryption Network Password value.

• Confirm Network Password: Confirm the encryption Network 
Password value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

The wireless network security window appears when the ad hoc network 
has security setting.

Select Open System or Shared Key for the authentication and click Next.

• WEP (Wired Equivalent Privacy) is a security protocol preventing 
unauthorized access to your wireless network. WEP encrypts the data 
portion of each packet exchanged on a wireless network using a 64-bit 
or 128-bit WEP encryption key.

 

12 The window showing the wireless network settings appears. Check the 
settings and click Next.

 

Before entering the IP address for the machine, you must know the 
computer’s network configuration information. If the computer’s network 
configuration is set to DHCP, the wireless network setting should also be 
DHCP. Likewise, if the computer’s network configuration is set to Static, the 
wireless network setting should also be Static.

If your computer is set to DHCP and you want to use Static wireless network 
setting, you must contact the network administrator to get the static IP 
address.

• For the DHCP method
If the IP address assignment method is DHCP, check if DHCP is shown in 
the Confirm Wireless Network Settings window. If it shows Static, click 
Change TCP/IP to change the assignment method to Receive IP 
address automatically (DHCP).

• For the Static method
If the IP address assignment method is Static, check if Static is shown in 
the Confirm Wireless Network Settings window. If it shows DHCP, click 
Change TCP/IP to enter the IP address and other network configuration 
values for the machine.
For example,
If the computer’s network information is shown as follows:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as shown below:
- IP address: 169.254.133.43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)
- Gateway: 169.254.133.1
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13 When the window that tells you that the network cable connection is 

confirmed appears, disconnect the network cable and click Next.

If the network cable is connected, it may have trouble finding the 
machine when configuring the wireless network.

14 The wireless network connects according to the network configuration.

15 Wireless network set up is completed. After installation is finished, click 
Quit.

 

After completing the wireless network connection, you need to install a 
machine driver to print from an application (see "Installation for Mac" on 
page 97).

 

10 

Setting the Wi-Fi Direct for mobile printing

Wi-Fi Direct is an easy-to-setup peer-to-peer connecting between method for 
your between a printer and mobile device that supports Wi-Fi Direct that 
provides a secure connection and better throughput than ad hoc mode.

With Wi-Fi Direct, you can connect your printer to a Wi-Fi Direct network while 
concurrently connecting to an access point, You can also use a wired network 
and a Wi-Fi Direct network simultaneously so multiple users can access and print 
documents both from Wi-Fi Direct and from a wired network.

 

• You cannot connect to the internet through the mobile device in use Wi-
Fi Direct.

• The supported protocol list may differ from your model, Wi-Fi Direct 
networks do NOT support IPv6, network filtering, IPSec, WINS, and SLP 
services. 

• Up to four mobile devices can connect to Wi-Fi Direct at one time.
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Setting up Wi-Fi Direct

You can enable Wi-Fi Direct feature by one of the following methods.

From the USB cable-connected computer(recommended)

• After the driver installation is complete, open Dell Printer Manager and 
make changes fot the Wi-Fi Direct setting.

 

Dell Printer Manager is available for Windows and Mac OS users only.

 

- From the Start menu, select Programs or All Programs > Dell Printers 
> your printer driver name >Dell Printer Manager > Device Settings > 
Network.

▪ Wi-Fi Direct On/Off: Select On to enable.

▪ Device Name: Enter the printer’s name for searching for your 
printer on a wireless network. By default, the device name is the 
model name.

▪ IP Address: Enter the IP address of the printer. This IP address is 
used only for the local network and not for the infrastructure wired 
or wireless network. We recommend using the default local IP 
address (the default local IP address of the printer for Wi-Fi Direct is 
192.168.3.1 )

▪ Group Owner: Activate this option to assign the printer the Wi-Fi 
Direct group’s owner. The Group Owner acts similar to a wireless 
access point. We recommend activating this option.

▪ Network Password: If your printer is a Group Owner, a Network 
Password is required for other mobile devices to connect to your 
printer. You can configure a Network Password yourself, or can 
remember the given Network Password that is randomly generated 
by default.

From the machine (Machines with a display screen)

• Select Network > Wireless > Wi-Fi Direct from the control panel.

• Enable Wi-Fi Direct.

Setting up the mobile device

• After setting up Wi-Fi Direct from the printer, refer to the user manual of the 
mobile device you are using to set its Wi-Fi Direct.

• After setting up Wi-Fi Direct, you need to download the mobile printing 
application (For example: Dell Mobile print) to print from your smartphone.

 

• When you have found the printer you want to connect to from your 
mobile device, select the printer and the printer's LED will blink. Press the 
WPS button on the printer and it will be connected to your mobile 
device.

• If your mobile device does not support WPS, you need to enter the 
"Network Password" of a printer instead of pushing the WPS button.
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What is Dell MobilePrint?

Dell MobilePrint is a free application that enables users to print photos, 
documents, and web pages directly from a smartphone or tablet. Dell 
MobilePrint is not only compatible with your Android, Windows and iOS smart 
phones but also with your iPod Touch and tablet PC. This program allows your 
mobile device to connect to a Dell printer over a wired network or a Wi-Fi access 
point. Installing a new driver or configuring network settings isn’t necessary – 
just simply install the Dell MobilePrint application, and it will automatically 
detect compatible Dell printers. Besides printing photos, web pages, and PDFs, 
scanning is also supported. If you have Dell multfunction printer, scan any 
document into a JPG, PDF, or PNG format for quick and easy viewing on your 
mobile device. 

12 

Downloading Dell MobilePrint

To download Dell MobilePrint, go to the application store (Dell Apps, Android 
Market, Play Store, Marketplace) on your mobile device, and just search for “Dell 
MobilePrint.” You can also visit iTunes for Apple devices or Marketplace for 
Windows devices on your computer.

13 

Supported Mobile OS 

• Android OS 2.1 or higher 

• iOS 4.0 or higher

• Windows Phone 7 or higher

14 

Supported devices

• iOS 4.0 or higher: iPod Touch, iPhone, iPad

• Android 2.1 or higher: Galaxy S, Galaxy S2, Galaxy Tab, and Android mobile 
devices

• Windows Phone 7 or higher: Dell Focus, Omnia7, and OmniaW, and 
Windows mobile devices
1292.  Using a Network-Connected Machine



Wireless network setup

15 

Troubleshooting

Problems during setup or driver installation

Printers Not Found

• Your machine may not be turned on. Turn on your computer and the 
machine.

• USB cable is not connected between your computer and machine. Connect 
the machine to your computer using the USB cable.

• The machine does not support wireless networking. Check the machine's 
user's guide included on the software CD supplied with your machine and 
prepare a wireless network machine.

Connecting Failure - SSID Not Found

• The machine is unable to find the network name (SSID) you have selected or 
entered. Check the network name (SSID) on your access point and try 
connecting again. 

• Your access point is not turned on. Turn on your access point.

Connecting Failure - Invalid Security

• Security is not configured correctly. Check the configured security on your 
access point and machine.

Connecting Failure - General Connection Error

• Your computer is not receiving a signal from your machine. Check the USB 
cable and your machine’s power.

Connecting Failure - Connected Wired Network

• Your machine is connected with a wired network cable. Remove the wired 
network cable from your machine.

PC Connection Error

• The configured network address is unable to connect between your 
computer and machine.

- For a DHCP network environment

The receives the IP address automatically (DHCP) when computer is 
configured to DHCP.

- For a Static network environment

The machine uses the static address when the computer is configured 
to static address.

For example,

If the computer’s network information is as shown below:
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▪ IP address: 169.254.133.42

▪ Subnet Mask: 255.255.0.0

Then the machine’s network information should be as below:

▪ IP address: 169.254.133.43

▪ Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)

▪ Gateway: 169.254.133.1

Other problems

If problems occur while using the machine on a network, check the following: 

 

For information on the access point (or wireless router), refer to its own 
user's guide. 

 

• Your computer, access point (or wireless router), or machine may not be 
turned on.

• Check the wireless reception around the machine. If the router is far from 
the machine or there is an obstacle, you might have difficulty receiving the 
signal. 

• Cycle the power for the access point (or wireless router), machine, and 
computer. Sometimes cycling the power can recover network 
communication.

• Check whether firewall software (V3 or Norton) is blocking the 
communication. 

If the computer and the machine are connected on the same network and it 
cannot be found when searching, firewall software might be blocking the 
communication. Refer to the user's guide for the software to turn it off and 
try searching for the machine again.

• Check whether the machine's IP address is allocated correctly. You can 
check the IP address by printing the network configuration report.

• Check whether the access point (or wireless router) has a configured 
security (password). If it has a password, refer to the access point (or wireless 
router) administrator.

• Check the machine's IP address. Reinstall the machine driver and change the 
settings to connect to the machine on the network. Due to the 
characteristics of DHCP, the allocated IP address could change if the 
machine is not used for a long time or if the access point has been reset.

Register the product's MAC address when you confogure the DHCP server 
on the access point (or wireless router). Then you can always use the IP 
address that is set with the MAC address. You can identify the Mac address 
of your machine by printing a network configuration report.

• Check the wireless environment. You might not be able to connect to the 
network in the infrastructure environment where you need to type in a 
user's information before connecting to the access point (or wireless router).

• This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other wireless 
communication types (e.g., Bluetooth) are not supported.
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• When using the ad hoc mode, in operating systems such as Windows Vista, 

you might need to set the wireless connection setting every time you use 
the wireless machine. 

• You cannot use infrastructure mode and ad hoc mode at the same time for 
Dell wireless network machines.

• The machine is within the range of the wireless network.

• The machine is located away from obstacles that could block the wireless 
signal.

Remove any large metal objects between the access point (or wireless 
router) and the machine.

Make sure the machine and wireless access point (or wireless router) are not 
separated by poles, walls, or support columns containing metal or concrete.

• The machine is located away from other electronic devices that may 
interfere with the wireless signal.

Many devices can interfere with the wireless signal, including a microwave 
oven and some Bluetooth devices.

• Whenever the configuration of your access point (or wireless router) 
changes, you must do the product's wireless network setup again.

• If Wi-Fi Direct is ON, this machine only supports IEEE 802.11 b/g.

• If the access point is set to work with the 802.11n standard only, it may 
notconnect to your machine.
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3. Special Features
This chapter explains special copying, scanning and printing features.
• Altitude adjustment 134
• Printing features 135
• Scan features 148
 

• The procedures in this chapter are mainly based on Windows 7.

 



Altitude adjustment

Print quality is affected by atmospheric pressure, which is determined by the 
height of the machine above sea level. The following information will guide you 
on how to set your machine for the best print quality.

Before you set the altitude value, determine the altitude where you are.

1 High 3
2 High 2
3 High 1
4 Normal

You can set the altitude value from Device Settings in Dell Printer Manager 
program.

• For Windows and Mac users, see "Device Settings" on page 162.

 

• You can also set the altitude in System Setup option on the machine’s 
display.

 

4,000 m
(13,123 ft) 

3,000 m
(9,842 ft) 

2,000 m
(6,561 ft) 

1,000 m
(3,280 ft) 

4

3

2

1

0
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• For basic printing features, refer to the Basic Guide (see "Basic printing" 
on page 36).

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

1 

Changing the default print settings

1 Click the Windows Start menu. 

2 Select Control Panel > Devices and Printers.

3 Right-click on your machine.

4 Select Printing preferences.

 

If Printing preferences has a ▶, you can select other printer drivers 
connected to the selected printer.

 

5 Change the settings on each tab. 

6 Click OK.

 

If you want to change the settings for each print job, change it in Printing 
Preferences. 

 

2 

Setting your machine as a default machine

1 Click the Windows Start menu.

2 Select Control Panel > Devices and Printers.

3 Select your machine.

4 Right-click your machine and select Set as Default Printer.

 

If Printing preferences has a ▶, you can select other printer drivers 
connected to the selected printer.
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Using advanced print features

 

XPS printer driver: used to print XPS file format. 

• See "Features by models" on page 7.

• The XPS printer driver can be installed only on Windows Vista OS or 
higher.

• Install optional memory when an XPS job does not print because the 
printer is out of memory.

• For models that provide XPS driver on the software CD:

- You can install the XPS printer driver when you insert the software CD 
into your CD/DVD drive. 

 

Printing to a file (PRN)

You will sometimes need to save the print data as a file. 

1 Check the Print to file box in the Print window.

2 Click Print.

3 Type in the destination path and the file name, and then click OK.

For example, c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in My 
Documents, Documents and Settings, or Users. The saved folder may 
differ, depending on your operating system or the application you are 
using.
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Understanding special printer features

You can use advanced printing features when using your machine.

To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window to change the print 
settings. The machine name, that appears in the printer properties window may differ depending on the machine in use.

 

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• Select the Help menu or click the  button from the window or press F1 on your keyboard and click on any option you want to know about (see "Using help" 
on page 39).

 

 

Item Description

Multiple Pages per 
Side

Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one sheet. 
1373.  Special Features



Printing features
Poster Printing
Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the upper right of Basic tab 
to make it easier to paste the sheets together.

Booklet Printinga

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half after printing to produce 
a booklet.

 

• If you want to make a booklet, you need to print on Letter, Legal, A4, US Folio, or Oficio sized print media. 

• The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under the Paper tab to see what 
paper sizes are available.

• If you select an unavailable paper size, this option can be automatically canceled. Select only available paper (paper without  or  
mark).

 

• Double-sided 
Printing

• Double-sided 
Printing (Manual)a

Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented. 

 

• You can use this feature with Letter, Legal, A4, US Folio or Oficio sized paper 

• If your machine does not have a duplex unit, you should complete the printing job manually. The machine prints every other page of 
the document first. After that, a message appears on your computer.

• Skip Blank Pages feature does not work when you select the duplex option.

 

Item Description

8 9
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• Double-sided 
Printing

• Double-sided 
Printing (Manual)a

 

Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

 

• Printer Default: If you select this option, this feature is determined by the settings you have selected on the control panel of the machine. 
This option is available only when you use the PCL/XPS printer driver.

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in bookbinding.

• Short Edge: This option is the conventional layout used in calendars.

• Reverse Double-Sided Printing: Check this option to reverse the print order when duplex printing. This option is not available when you 
use Double-sided Printing (Manual).

Paper Options Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which to enlarge or decrease the 
document.

Item Description
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Watermark The watermark option allows you to print text over an existing document. For example, you use it when you want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document. 

Watermark

(Creating a 
watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Enter a text message in the Watermark Message box. 

You can enter up to 256 characters. The message displays in the preview window.

Watermark

(Editing a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options. 
d Click Update to save the changes.
e Click OK or Print until you exit the Print window. 

Watermark

(Deleting a 
watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to delete from the Current Watermarks list and click Delete. 
d Click OK or Print until you exit the Print window.

Item Description
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Overlaya

This option is available only when you use the PCL/SPL printer driver (see "Software" on page 7).

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing 
exactly the same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not need to load 
preprinted letterhead paper in the machine: just print the letterhead overlay on your document.

To use a page overlay, you must create a new page overlay containing your logo or image.

 

• The overlay document size must be the same as the document you print with the overlay. Do not create an overlay with a watermark.

• The resolution of the overlay document must be the same as that of the document you will print with the overlay.

 

Overlaya

(Creating a new page 
overlay)

a To save the document as an overlay, access Printing Preferences.
b Click the Advanced tab, and select Edit from the Text drop-down list. Edit Overlay window appears.
c In the Edit Overlay window, click Create. 
d In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if necessary (The default is 

C:\Formover).
e Click Save. The name appears on the Overlay List. 
f Click OK or Print until you exit the Print window.

The file is not printed. Instead, it is stored on your computer hard disk drive.

Item Description
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Overlaya

(Using a page overlay)

a Click the Advanced tab. 
b Select the desired overlay from the Text drop-down list. 
c If the overlay file you want does not appear in the Text drop-down list, select Edit... from the list and click Load. Select the overlay file you 

want to use. 
If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Open window. 
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the Overlay 
List box. 

d If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears each time you submit a 
document for printing, asking you to confirm printing an overlay on your document. 
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document. 

e Click OK or Print until you exit the Print window. 

Overlaya

(Deleting a page 
overlay)

a In the Printing Preferences window, click the Advanced tab. 
b Select Edit in the Text drop down list. 
c Select the overlay you want to delete from the Overlay List box. 
d Click Delete. 
e When a confirming message window appears, click Yes.
f Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

Item Description
1423.  Special Features



Printing features
 

Print Mode

 

• This feature is available only if you have installed the optional memory or mass storage device (HDD) (see "Variety feature" on page 8).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

 

• Print Mode: The default Print Mode is Normal, which is for printing without saving the printing file in the memory. 

- Normal: This mode prints without storing your document in the optional memory. 

- Proof: This mode is useful when you print more than one copy. You can print one copy first to check, then print the rest of the copies later. 

- Confidential: This mode is used for printing confidential documents. You need to enter a password to print. 

- Store: Select this setting to save a document in the mass storage device (HDD) without printing. 

- Store and Print: This mode is used when printing and storing document at the same time. 

- Spool: This option can be useful when handling large amounts of data. If you select this setting, the printer spools the document into the 
mass storage device (HDD) and then prints it from the mass storage device (HDD) queue, decreasing the computer’s work load.

- Print Schedule: Select this setting to print the document at a specified time.

• User ID: This option is used when you need to find a saved file using the control panel. 

• Job Name: This option is used when you need to find a saved file using the control panel. 

Job Encryption

Encrypts printing data first, and transmits it to the machine. This feature protects the printing information even though the data is snatched on 
a network.

 

Job Encryption feature is enabled only when the mass storage device (HDD) is installed. The mass storage device (HDD) is used to 
decrypt the printing data (see "Variety feature" on page 8).

 

a. This option is not available when you use XPS driver.

Item Description
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4 

Mac printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing a document

When you print with a Mac, you need to check the printer driver settings in each 
application you use. Follow the steps below to print from a Mac:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup in some 
applications).

3 Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4 Open the File menu and click Print. 

5 Choose the number of copies and indicate which pages to print. 

6 Click Print.

Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The machine name, 
which appears in the printer properties window, may differ depending on the 
machine in use. Except for the name, the composition of the printer properties 
window is similar to the following.

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In the Pages 
per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3 Select the other options to use.

4 Click Print. 

The machine prints the selected number of pages to print on one sheet 
of paper.
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Printing on both sides of the paper

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Variety feature" on page 8).

 

Before printing in the duplex mode, decide on which edge you will be binding 
your finished document. The binding options are, as follows:

• Long-Edge Binding: This option is the conventional layout used in book 
binding.

• Short-Edge Binding: This option is the type often used with calendars.

1 From your Mac application, select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. 

3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy might 
print on the same sheet of paper. Avoid printing on both sides of paper 
when you are printing more than 1 copy.

 

Using help

Click the question mark on the bottom-left corner of the window and click on 
the topic you want to know about. A pop-up window appears with information 
about that option's feature, which is provided from the driver. 
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5 

Linux printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing from applications

There are a lot of Linux applications that allow you to print using Common UNIX 
Printing System (CUPS). You can print on your machine from any such 
application.

1 Open the document to print

2 Open the File menu and click Page Setup (Print Setup in some 
applications).

3 Choose your paper size, orientation, and make sure that your machine is 
selected. Click Apply.

4 Open the File menu and click Print.

5 Select your machine to print.

6 Choose the number of copies and indicate which page to print.

7 Change other printing options in each tab, if necessary.

8 Click Print.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing.

 

Printing files

You can print many different types of files on your machine using the standard 
CUPS, directly from the command line interface. The CUPS lpr utility allows you 
to do that. You can print these files by using the command format below.

lp -d <printer name> -o <option> <file name>

Please refer to lp or man page on your system for more details.

Configuring Printer Properties

Using the Printer Properties window provided by the Printers configuration, 
you can change the various properties for your machine as a printer.
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1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.

2 Select your machine on the available printers list and click Properties.

3 The Printer Properties window appears.

The following five tabs display at the top of the window:

• General: Allows you to change the printer location and name. The 
name entered in this tab displays on the printer list in Printers 
configuration.

• Connection: Allows you to view or select another port. If you change 
the machine port from USB to parallel or vice versa while in use, you 
must re-configure the machine port in this tab.

• Driver: Allows you to view or select another machine driver. By 
clicking Options, you can set the default device options.

• Jobs: Shows the list of print jobs. Click Cancel job to cancel the 
selected job and select the Show completed jobs check box to see 
previous jobs on the job list.

• Classes: Shows the class that your machine is in. Click Add to Class 
to add your machine to a specific class or click Remove from Class 
to remove the machine from the selected class.

4 Click OK to apply the changes and close the Printer Properties window.
1473.  Special Features



Scan features

 

• For basic scanning features, refer to the Basic Guide (see "Basic scanning" 
on page 43).

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

• The maximum resolution that can be achieved depends upon various 
factors, including computer speed, available disk space, memory, the 
size of the image being scanned, and bit depth settings. Thus, depending 
on your system and what you are scanning, you may not be able to scan 
at certain resolutions, especially using enhanced dpi.

 

6 

Basic scanning method

 

This feature may not be available depending on model or optional goods 
(see "Variety feature" on page 8).

 

You can scan the originals with your machine via an USB cable or the network. 
The following methodoloqies can be used for scanning your documents:

• Scan to PC: Scan the originals from the control panel. Then, the scanned 
data will be stored in the connected computers My Documents folder (see 
"Basic Scanning" on page 43).

• TWAIN: TWAIN is the one of a preset imaging applications. Scanning an 
image launches the selected application, enabling you to control the 
scanning process. This feature can be used via the local connection or the 
network connection (see "Scanning from image editing program" on page 
149).

• Dell Scan Assistant: You can use this program to scan images or 
documents.

- See "Scanning with Dell Scan Assistant" on page 150.

• WIA: WIA stands for Windows Images Acquisition. To use this feature, your 
computer must be connected directly with the machine via an USB cable 
(see "Scanning using the WIA driver" on page 150).

• USB Memory: You can scan a document and save the scanned image onto 
an USB memory device.

• Email: You can send the scanned image as an email attachment.

• FTP/SMB: You can scan an image and upload it to an FTP/SMB server.
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Setting the scan settings in the computer

 

This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

1 Open Dell Printer Manager (see "Using Dell Printer Manager" on page 
160).

2 Select the appropriate machine from the Printer List.

3 Select Scan to PC Settings menu.

4 Select the option you want.

• Scan Activation: Determines whether or not scanning is enabled on 
the device.

• Basic tab: Contains settings related to general scan and device 
settings.

• Image tab: Contains settings related to image altering.

5 Press Save > OK.

8 

Scanning from image editing program

You can scan and import documents at the image editing software such as 
Adobe Photoshop, if the software is TWAIN-compliant. Follow the steps below 
to scan with TWAIN-compliant software:

1 Make sure that the machine is connected to your computer and 
powered on.

2 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 34).

3 Open an application, such as Adobe Photoshop.

4 Click File > Import, and select the scanner device.

5 Set the scan options.

6 Scan and save your scanned image.
1493.  Special Features



Scan features

9 

Scanning using the WIA driver

Your machine supports the Windows Image Acquisition (WIA) driver for 
scanning images. WIA is one of the standard components provided by Microsoft 
Windows 7 and works with digital cameras and scanners. Unlike the TWAIN 
driver, the WIA driver allows you to scan and easily adjust images without using 
additional software:

 

The WIA driver works only on Windows OS (not supported Windows 2000) 
with a USB port.

 

1 Make sure that the machine is connected to your computer and 
powered on.

2 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 34).

3 Click Start > Control Panel > Hardware and Sound > Devices and 
Printers.

4 Right-click on device driver icon in Printers and Faxes > Start Scan.

5 New Scan application appears.

6 Choose your scanning preferences and click Preview to see your 
preferences affect the picture.

7 Scan and save your scanned image.

10 

Scanning with Dell Scan Assistant

 

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

• For Windows, you need to install the printer software from the supplied 
CD/DVD. For Mac, open the Applications folder > Dell folder > DellScan 
Assistant.

 

1 Download the software from the Dell website then unpack andinstall it.

2 Make sure that the machine is connected to your computer and 
powered on.

3 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 34).

4 Click Start > All programs > Dell Printers, and start Dell Scan 
Assistant.
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Select the Help menu from the window and click on any option you want to 
know about. 

 

5 Set the scan options.

6 Click Scan.

11 

Mac scanning

Scanning from USB connected machine

1 Make sure that the machine is connected to your computer and 
powered on.

2 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 34).

3 Start Applications and click Image Capture. 

 

If No Image Capture device connected message appears, disconnect the 
USB cable and reconnect it. If the problem continues, refer to the Image 
Capture’s help.

 

4 Select the option you want. 

5 Scan and save your scanned image.

 

If scanning does not operate in Image Capture, update Mac OS to the latest 
version. 

 

Scanning from network connected machine

 

Network or wireless model only (see "Features by models" on page 7).

 

1 Make sure that your machine is connected to a network.

2 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 34).

3 Start Applications and click Image Capture. 

4 According to OS, follow steps below. 

• For 10.5

- Click Devices > Browse Devices on Menu bar.

- Make sure that Connected checkbox is checked beside your 
machine in Bonjour Devices.
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• For 10.6 -10.9, select your device below SHARED.

5 Set the scan options on this program.

6 Scan and save your scanned image.

 

• If scanning does not operate in Image Capture, update Mac OS to the 
latest version. 

• For more information, refer to the Image Capture’s help.

• You can also scan using TWAIN-compliant software, such as Adobe 
Photoshop.

 

12 

Linux scanning

Scanning

1 Make sure that the machine is connected to your computer and 
powered on.

2 Double-click the Unified Driver Configurator on your desktop. 

3 Click the  button to switch to Scanners Configuration. 

4 Select the scanner on the list.

5 Click Properties. 

6 Place a single document face down on the document glass, or load the 
documents face up into the document feeder (see "Loading originals" on 
page 34).

7 From the Scanner Properties window, click Preview.
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8 The document is scanned and the image preview appears in the 

Preview Pane.

9 Drag the pointer to set the image area to be scanned in the Preview 
Pane.

10 Select the option you want. 

11 Scan and save your scanned image.

 

For later use, you can save as your scan settings and add it to the Job Type 
drop-down list. 

 

Editing an image with Image Manager

The Image Manager application provides you with menu commands and tools 
to edit your scanned image.
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4. Useful Management 
Tools

This chapter introduces management tools provided to help you make full use of your machine. 
• Accessing management tools 155
• Using Firmware update utility 156
• Using Dell Supplies Ordering Utility 157
• Using Embedded Web Service 158
• Using Dell Printer Manager 160
• Using Dell Printer Status 163
• Using the Linux Unified Driver Configurator 165



Accessing management tools

Dell provides a variety of management tools for Dell printers. 

1 Make sure that the machine is connected to your computer and powered on.

2 From the Start menu, select Programs or All Programs.

• For Windows 8, from the Charms, select Search > Apps.

3 Find Dell Printers.

4 Under Dell Printers, you can see installed management tools.

5 Click the management tool you want to use.

 

• After installing the driver, for some management tools, you can access them directly from the Start screen by clicking on the corresponding tile.

• For Windows 8, after installing the driver, for some management tools, you can access them directly from the Start screen by clicking on the corresponding tile.
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Using Firmware update utility

Firmware Update Utility allows you to maintain your machine by upgrading firmware.

1 From the Start menu, select Programs or All Programs >  Dell Printers > your printer driver name > Firmware Update Utility.

2 Download the latest firmware. Click http://www.dell.com/support.

3 If your printer is connected with an USB cable, click USB Connected Printer or Network Connected Printer.

4 Click Browse and select the downloaded firmware file.

5 Click Update Firmware.
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Using Dell Supplies Ordering Utility

To order replacement toner cartridges or supplies from Dell:

 

Availabe for Windows or Mac OS users only.

 

1 Double-click the Dell Supplies Ordering Utility icon on your desktop.

OR

From the Start menu, select Programs or All Programs > Dell Printers 
> your printer driver name > Dell Supplies Ordering Utility.

 

For Mac,

Open the Applications folder > Dell folder > Dell Supplies Ordering 
Utility.

 

2 The Dell Supplies Ordering Utility window opens.
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Using Embedded Web Service

 

• Internet Explorer 6.0 or higher is the minimum requirement for 
Embedded Web Service.

• Embedded Web Service explanation in this user’s guide may differ from 
your machine depending on its options or models.

• Network model only (see "Software" on page 7).

 

1 

Accessing Embedded Web Service

1 Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address of your printer (http://xxx.xxx.xxx.xxx) in 
the address field and press the Enter key or click Go.

2 Your machine’s embedded website opens.

Logging into Embedded Web Service

Before configuring options in Embedded Web Service, you need to log-in as an 
administrator. You can still use Embedded Web Service without logging in but 
you won’t have access to Settings tab and Security tab. 

1 Click Login on the upper right of the Embedded Web Service website.

2 Type in the ID and Password then click Login.

• ID: admin 

• Password: dell00000

2 

Embedded Web Service overview

 

Some tabs may not appear depending on your model.

 

Information tab

This tab gives you general information about your machine. You can check 
things, such as remaining amount of toner. You can also print reports, such as an 
error report.

• Active Alerts: Shows the alerts that have occurred in the machine and their 
severity.

• Supplies: Shows how many pages are printed and amount of toner left in 
the cartridge.
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• Usage Counters: Shows the usage count by print types: simplex and 

duplex.

• Current Settings: Shows the machine’s and network’s information. 

• Print information: Prints reports such as system related reports, e-mail 
address, and font reports.

Settings tab

This tab allows you to set configurations provided by your machine and 
network. You need to log-in as an administrator to view this tab. 

• Machine Settings tab: Sets options provided by your machine. 

• Network Settings tab: Shows options for the network environment. Sets 
options such as TCP/IP and network protocols. 

Security tab

This tab allows you to set system and network security information. You need to 
log-in as an administrator to view this tab.

• System Security: Sets the system administrator’s information and also 
enables or disables machine features.

• Network Security: IPv4/IPv6 filtering.

• User Access Control: Classifies users into several groups according to each 
user’s role. Each user’s authorization, authentication and accounting will be 
controlled by the group’s role definition.

Maintenance tab

This tab allows you to maintain your machine by upgrading firmware and 
setting contact information for sending emails. You can also connect to Dell 
website or download drivers by selecting the Link menu.

• Firmware Upgrade: Upgrade your machine’s firmware.

• Contact Information: Shows the contact information.

• Link: Shows links to useful sites where you can download or check 
information.
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Using Dell Printer Manager 

 

• Available for Windows and Mac OS users only (see "Software" on page 7).

• For Windows, Internet Explorer 6.0 or higher is the minimum 
requirement for Dell Printer Manager.

 

Dell Printer Manager is an application that combines Dell machine settings into 
one location. Dell Printer Manager combines device settings as well as printing 
environments, settings/actions and launching. All of these features provide a 
gateway to conveniently use your Dell machine. Dell Printer Manager provides 
two different user interfaces for the user to choose from: the basic user interface 
and the advanced user interface. Switching between the two interfaces is easy: 
just click a button.

3 

Understanding Dell Printer Manager

To open the program: 

For Windows,

Select Start > Programs or All Programs > Dell > Dell Printers > Dell Printer 
Manager > Dell Printer Manager.

For Mac,

Open the Applications folder > Dell folder > Dell Printer Manager.

The Dell Printer Manager interface is comprised of various basic sections as 
described in the table that follows:

 

The screenshot may differ depending on operating system you are using.

 

1
Printer list The Printer List displays printers installed on your 

computer and network printers added by network 
discovery (Windows only).
1604.  Useful Management Tools



Using Dell Printer Manager
 

Select the Help menu or click the  button from the window and click on 
any option you want to know about. 

 

2

Printer 
information

This area gives you general information about your 
machine. You can check information, such as the machine’s 
model name, IP address (or Port name), and machine 
status.

 

You can view the online User’s Guide.

 

3

Application 
information

Includes links for changing to the advanced settings, 
preference, help, and about.

 

The  button is used to change the user 
interface to the advanced settings user interface 
(see "Advanced settings user interface overview" 
on page 162).

 

4

Quick links Displays Quick links to machine specific functions. This 
section also includes links to applications in the advanced 
settings.

 

If you connect your machine to a network, the 
Embedded Web Service icon is enabled.

 

5

Contents area Displays information about the selected machine, 
remaining toner level, and paper. The information will vary 
based on the machine selected. Some machines do not 
have this feature.

6
Order supplies Click on the Order button from the supply ordering 

window. You can order replacement toner cartridge(s) 
from online.
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4 

Advanced settings user interface overview

The advanced user interface is intended to be used by the person responsible 
for managing the network and machines.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

Device Settings

You can configure various machine settings such as machine setup, paper, 
layout, emulation, network, and print information.

Scan to PC Settings

This menu includes settings to create or delete scan to PC profiles. 

• Scan Activation: Determines whether or not scanning is enabled on the 
device.

• Profile: Displays the scanning profiles saved on the selected device.

• Basic tab: Contains settings related to general scan and device settings.

• Image tab: Contains settings related to image altering.

Alert Settings (Windows only)

This menu includes settings related to error alerting. 

• Printer Alert: Provides settings related to when alerts will be received.

• Email Alert: Provides options relating to receiving alerts via email.

• Alert History: Provides a history of device and toner related alerts.
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The Dell Printer Status is a program that monitors and informs you of the 
machine status. 

 

• The Dell Printer Status window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in use.

• Check the operating system(s) that are compatible with your machine 
(see "Specifications" on page 71).

• Available for Windows OS users only (see "Software" on page 7).

 

5 

Dell Printer Status overview

If an error occurs while operating, you can check the error from the Dell Printer 
Status. Dell Printer Status is installed automatically when you install the machine 
software. 

You can also launch Dell Printer Status manually. Go to the Printing 
Preferences, click the Basic tab > Printer Status button.

These icons appear on the Windows task bar:

Icon Mean Description

Normal The machine is in ready mode and experiencing no 
errors or warnings.

Warning The machine is in a state where an error might occur in 
the future. For example, it might be in toner low status, 
which may lead to toner empty status. 

Error The machine has at least one error.

1

Toner Level You can view the level of toner remaining in each 
toner cartridge. The machine and the number of 
toner cartridge(s) shown in the above window may 
differ depending on the machine in use. Some 
machines do not have this feature.
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2 Option You can set printing job alert related settings. 

3
Order Supplies You can order replacement toner cartridge(s) from 

online.

4 User’s Guide You can view the online User’s Guide.

5 Close Close the window.
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Using the Linux Unified Driver Configurator

The Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified Driver 
Configurator (see "Installation for Linux" on page 99).

After the driver is installed on your Linux system, the Unified Driver Configurator 
icon will automatically be created on your desktop.

6 

Opening Unified Driver Configurator

1 Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select DELL Unified 
Driver > Unified Driver Configurator.

2 Click each button on the left to switch to the corresponding 
configuration window.

1 Printer Configuration 
2 Port Configuration 

 

To use the on screen help, the Help or  button from the window.

 

3 After changing the configurations, click Exit to close the Unified Driver 
Configurator.
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7 

Printers configuration

Printers configuration has the two tabs: Printers and Classes.

Printers tab

View the current system’s printer configuration by clicking on the machine icon 
button on the left side of the Unified Driver Configurator window.

The printer control buttons are, as follows:

• Refresh: Renews the available machines list.

• Add Printer: Allows you to add a new machines.

• Remove Printer: Removes the selected machine.

• Set as Default: Sets the current selected machine as a default machine.

• Stop/Start: Stops/starts the machine.

• Test: Allows you to print a test page to ensure the machine is working 
properly.

• Properties: Allows you to view and change the printer’s properties. 

1 Switches to Printers configuration.

2 Shows all of the installed machines.

3 Shows the status, model name, and URI of your machine.
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Classes tab

The Classes tab shows a list of available machine classes.

• Refresh: Renews the classes list.

• Add Class: Allows you to add a new machine class.

• Remove Class: Removes the selected machine class.

8 

Ports configuration

In this window, you can view the list of available ports, check the status of each 
port and release a port that is stalled in a busy state when its owner has 
terminated the job for any reason.

• Refresh: Renews the available ports list.

• Release port: Releases the selected port.

1 Shows all of the machine classes.

2 Shows the status of the class and the number of machines in the class.
1 Switches to Ports configuration.

2 Shows all of the available ports.

3 Shows the port type, device connected to the port, and status.
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5. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
• Paper feeding problems 169
• Power and cable connecting problems 170
• Printing problems 171
• Printing quality problems 175
• Copying problems 183
• Scanning problems 184
• Operating system problems 185



Paper feeding problems
Condition Suggested solutions

Paper jams during printing. Clear the paper jam.

Paper sticks together. • Check the maximum paper capacity of the tray.

• Make sure that you are using the correct type of paper.

• Remove paper from the tray and flex or fan the paper.

• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed. Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.

Paper does not feed into the machine. • Remove any obstructions from inside the machine.

• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove excess paper from the tray.

• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming. • There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special materials, use the 
manual feeding in tray.

• An incorrect type of paper is being used. Use only paper that meets the specifications required by the machine.

• There may be debris inside the machine. Open the front cover and remove any debris.

Envelopes skew or fail to feed correctly. Ensure that the paper guides are against both sides of the envelopes.
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Power and cable connecting problems
Condition Suggested solutions

The machine is not receiving power, 

or the connection cable between the 
computer and the machine is not 
connected properly.

• Connect the machine to the electricity supply first. If the machine has a  (Power/Wakeup) button on the control, 

press it. 

• Disconnect the machine’s cable and reconnect it.
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Printing problems
Condition Possible cause Suggested solutions

The machine does not 
print.

The machine is not receiving power. Connect the machine to the electricity supply first. If the machine has a  (Power/

Wakeup) button on the control, press it. 

The machine is not selected as the default 
machine.

Select your machine as your default machine in Windows.

Check the machine for the following:

• The cover is not closed. Close the cover.

• Paper is jammed. Clear the paper jam (see "Clearing paper jams" on page 64).

• No paper is loaded. Load paper (see "Loading paper in the tray" on page 27).

• The toner cartridge is not installed. Install the toner cartridge (see "Replacing the toner cartridge" on page 53).

• Make sure the protect cover and sheets are removed from the toner cartridge (see "Replacing the toner cartridge" on page 53).

If a system error occurs, contact your service representative.

The connection cable between the computer and 
the machine is not connected properly.

Disconnect the machine cable and reconnect it (see "Rear view" on page 18).

The connection cable between the computer and 
the machine is defective.

If possible, attach the cable to another computer that is working properly and print a job. 
You can also try using a different machine cable.

The port setting is incorrect. Check the Windows printer settings to make sure that the print job is sent to the correct 
port. If the computer has more than one port, make sure that the machine is attached to 
the correct one.
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Printing problems
The machine does not 
print.

The machine may be configured incorrectly. Check the Printing Preferences to ensure that all of the print settings are correct.

The printer driver may be incorrectly installed. Uninstall and reinstall the machine’s driver.

The machine is malfunctioning. Check the display message on the control panel to see if the machine is indicating a 
system error. Contact a service representative.

The document size is so big that the hard disk 
space of the computer is insufficient to access the 
print job.

Get more hard disk space and print the document again.

The output tray is full. Once the paper is removed from the output tray, the machine resumes printing.

The machine selects print 
materials from the wrong 
paper source.

The paper option that was selected in the 
Printing Preferences may be incorrect.

For many software applications, the paper source selection is found under the Paper tab 
within the Printing Preferences (see "Opening printing preferences" on page 37). 
Select the correct paper source. See the printer driver help screen (see "Using help" on 
page 39).

A print job is extremely 
slow.

The job may be very complex. Reduce the complexity of the page or try adjusting the print quality settings.

Half the page is blank. The page orientation setting may be incorrect. Change the page orientation in your application (see "Opening printing preferences" on 
page 37). See the printer driver help screen (see "Using help" on page 39).

The paper size and the paper size settings do not 
match.

Ensure that the paper size in the printer driver settings matches the paper in the tray.Or, 
ensure that the paper size in the printer driver settings matches the paper selection in 
the software application settings you use (see "Opening printing preferences" on page 
37).

The machine prints, but 
the text is wrong, 
garbled, or incomplete.

The machine cable is loose or defective. Disconnect the machine cable and reconnect. Try a print job that you have already 
printed successfully. If possible, attach the cable and the machine to another computer 
that you know works and try a print job. Finally, try a new machine cable.

Condition Possible cause Suggested solutions
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Printing problems
The wrong printer driver was selected. Check the application’s printer selection menu to ensure that your machine is selected.

The software application is malfunctioning. Try printing a job from another application.

The operating system is malfunctioning. Exit Windows and reboot the computer. Turn the machine off and back on again.

Pages print, but they are 
blank.

The toner cartridge is defective or out of toner. Redistribute the toner, if necessary. If necessary, replace the toner cartridge.

• See "Redistributing toner" on page 51.

• See "Replacing the toner cartridge" on page 53.

The file may have blank pages. Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the board, 
may be defective.

Contact a service representative.

The machine does not 
print PDF files correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and the 
Acrobat products.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image 
from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

The print quality of 
photos is not good. 
Images are not clear.

The resolution of the photo is very low. Reduce the photo size. If you increase the photo size in the software application, the 
resolution will be reduced. 

Before printing, the 
machine emits vapor near 
the output tray.

Using damp paper can cause vapor during 
printing.

This is not a problem. Just keep printing.

Condition Possible cause Suggested solutions
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Printing problems
The machine does not 
print special-sized paper, 
such as billing paper.

Paper size and paper size setting do not match. Set the correct paper size in the Custom in Paper tab in Printing Preferences (see 
"Opening printing preferences" on page 37).

The printed billing paper 
is curled.

The paper type setting does not match. Change the printer option and try again. Go to Printing Preferences, click Paper tab, 
and set type to Thick (see "Opening printing preferences" on page 37).

Machine information is not 
displayed when you click 
the device in the Devices 
and Printers.

Check the Printer properties. Click the Ports tab.

(Control Panel > Devices and Printers > Right-
click on your printer icon and select Printer 
properties)

If the port is set to File or LPT, uncheck them and 
select TCP/IP, USB, or WSD.

Machine information is not displayed when you click the device in the Devices and 
Printers.

The error related toast 
message pops up. 

The error related toast message pops up. 

Condition Possible cause Suggested solutions
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Printing quality problems

If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in print quality. See the table below to clear the problem. 

 

Condition Suggested solutions

Light or faded print • If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge (see "Replacing the 
toner cartridge" on page 53).

• The paper may not meet paper specifications; for example, the paper may be too moist or rough.

• If the entire page is light, the print resolution setting is too low or the toner save mode is on. Adjust the print resolution and turn 
the toner save mode off. See the help screen of the printer driver.

• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the inside of your machine 
(see "Cleaning the machine" on page 55).

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
55). If these steps do not correct the problem, contact a service representative.

The top half of the paper is 
printed lighter than the rest of 
the paper

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 37).
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Printing quality problems
Toner specks • The paper may not meet specifications; for example, the paper may be too moist or rough.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 55).

• The paper path may need cleaning. Contact a service representative (see "Cleaning the machine" on page 55).

Dropouts If faded areas, generally rounded, occur randomly on the page:

• A single sheet of paper may be defective. Try reprinting the job.

• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper.

• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick (see "Opening 
printing preferences" on page 37).

If these steps do not correct the problem, contact a service representative.

White Spots If white spots appear on the page:

• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the transfer roller may be 
dirty. Clean the inside of your machine (see "Cleaning the machine" on page 55).

• The paper path may need cleaning. Clean the inside of your machine (see "Cleaning the machine" on page 55).

If these steps do not correct the problem, contact a service representative.

Condition Suggested solutions
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Printing quality problems
Vertical lines If black vertical streaks appear on the page:

• The surface (drum part) of the toner cartridge inside the machine has probably been scratched. Remove the toner cartridge and 
install a new one (see "Replacing the toner cartridge" on page 53).

If white vertical streaks appear on the page:

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
55). If these steps do not correct the problem, contact a service representative.

Black or color background If the amount of background shading becomes unacceptable:

• Change to a lighter weight paper.

• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can increase the amount 
of background shading.

• Remove the old toner cartridge and install a new one (see "Replacing the toner cartridge" on page 53).

• Thoroughly redistribute the toner (see "Redistributing toner" on page 51).

Toner smear • Clean the inside of the machine (see "Cleaning the machine" on page 55).

• Check the paper type and quality.

• Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on page 53).

Condition Suggested solutions
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Printing quality problems
Vertical repetitive defects If marks repeatedly appear on the printed side of the page at even intervals:

• The toner cartridge may be damaged. If you still have the same problem, remove the toner cartridge and, install a new one (see 
"Replacing the toner cartridge" on page 53).

• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after 
a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter Background scatter results from bits of toner randomly distributed on the printed page. 

• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that 
the paper does not absorb too much moisture.

• If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have overlapping seams 
on the reverse side. Printing on seams can cause problems.
Or select Thick from the Printing Preferences window (see "Opening printing preferences" on page 37).

• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application 
or in Printing Preferences (see "Opening printing preferences" on page 37). Ensure the correct paper type is selected. For example: 
If Thicker Paper is selected, but Plain Paper actually used, an overcharging can occur causing this copy quality problem.

• If you are using a new toner cartridge, redistribute the toner first (see "Redistributing toner" on page 51).

Toner particles are around bold 
characters or pictures

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 37).

• Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain Paper actually used, an overcharging 
can occur causing this copy quality problem.

Condition Suggested solutions
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Printing quality problems
Misformed characters • If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try different paper.

Page skew • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Ensure that the guides are not too tight or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.

• Check the paper type and quality. Both high temperature and humidity can cause paper curl.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Condition Suggested solutions
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Printing quality problems
Wrinkles or creases • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are dirty • Check for leaking toner. Clean the inside of the machine (see "Cleaning the machine" on page 55).

Solid color or black pages • The toner cartridge may not be installed properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 53).

• The machine may require repairing. Contact a service representative.

Condition Suggested solutions
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Printing quality problems
Loose toner • Clean the inside of the machine (see "Cleaning the machine" on page 55).

• Check the paper type and quality.

• Remove the toner cartridge and then, install a new one (see "Replacing the toner cartridge" on page 53).

If the problem persists, the machine may require repair. Contact a service representative.

Character voids Character voids are white areas within parts of characters that should be solid black:

• You may be printing on the wrong surface of the paper. Remove the paper and turn it around. 

• The paper may not meet paper specifications.

Horizontal stripes If horizontally aligned black streaks or smears appear:

• The toner cartridge may be installed improperly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 53).

If the problem persists, the machine may require repairing. Contact a service representative.

Condition Suggested solutions
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Printing quality problems
 

Curl If the printed paper is curled or paper does not feed into the machine:

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray. 

• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thin (see 
"Opening printing preferences" on page 37).

• An unknown image 
repetitively appears on a few 
sheets

• Loose toner

• Light print or contamination 
occurs

Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.The high altitude may affect the print quality, such 
as loose toner or light imaging. Change the altitude setting for your machine (see "Altitude adjustment" on page 134).

Condition Suggested solutions
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Copying problems
Condition Suggested solutions

Copies are too light or too dark. Adjust the darkness in copy feature to lighten or darken the backgrounds of copies.

Smears, lines, marks, or spots 
appear on copies.

• If the defects are on the original, adjust darkness in copy feature to lighten the background of your copies.

• If there are no defects on the original, clean the scan unit (see "Cleaning the scan unit" on page 59).

Copy image is skewed. • Ensure that the original is aligned with the registration guide.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 55).

Blank copies print out. Ensure that the original is face down on the scanner glass or face up in the document feeder.

If these steps do not correct the problem, contact a service representative.

Image rubs off the copy easily. • Replace the paper in the tray with paper from a new package.

• In high humidity areas, do not leave paper in the machine for extended periods of time.

Frequent copy paper jams 
occur.

• Fan the paper, then turn it over in the tray. Replace the paper in the tray with a fresh supply. Check/adjust the paper guides, if 
necessary.

• Ensure that the paper is the proper type and weight (see "Print media specifications" on page 73).

• Check for copy paper or pieces of copy paper remaining in the machine after a paper jam has been cleared.

Toner cartridge produces fewer 
copies than expected before 
running out of toner.

• Your originals may contain pictures, solids, or heavy lines. For example, your originals may be forms, newsletters, books, or other 
documents that use more toner.

• The scanner lid may be left open while copies are being made.

• Turn the machine off and back on.
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Scanning problems
Condition Suggested solutions

The scanner does not work. • Make sure that you place the original to be scanned face down on the scanner glass, or face up in the document feeder (see 
"Loading originals" on page 34).

• There may not be enough available memory to hold the document you want to scan. Try the Prescan function to see if that works. 
Try lowering the scan resolution rate.

• Check that the machine printer cable is connected properly.

• Make sure that the machine printer cable is not defective. Switch the printer cable with a known good cable. If necessary, replace 
the printer cable.

The unit scans very slowly. • Check if the machine is printing received data. If so, scan the document after the received data has been printed.

• Graphics are scanned more slowly than text.

• Communication speed slows in scan mode because of the large amount of memory required to analyze and reproduce the scanned 
image. Set your computer to the ECP printer mode through BIOS setting. It will help to increase the speed. For details about how 
to set BIOS, refer to your computer user’s guide.

Message appears on your 
computer screen:

• Device can’t be set to the H/W 
mode you want.

• Port is being used by another 
program.

• Port is disabled.

• Scanner is busy receiving or 
printing data. When the 
current job is completed, try 
again.

• Invalid handle.

• Scanning has failed.

• There may be a copying or printing job in progress. Try your job again when that job is finished.

• The selected port is currently being used. Restart your computer and try again.

• The machine printer cable may be improperly connected or the power may be off.

• The scanner driver is not installed or the operating environment is not set up properly.

• Ensure that the machine is properly connected and the power is on, then restart your computer.

• The USB cable may be improperly connected or the power may be off.
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Operating system problems

1 

Common Windows problems

 

Refer to the Microsoft Windows User’s Guide that came with your computer for further information on Windows error messages.

 

Condition Suggested solutions

“File in Use” message appears 
during installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the printer driver.

“General Protection Fault”, 
“Exception OE”, “Spool 32”, or 
“Illegal Operation” messages 
appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer 
timeout error occurred” 
message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message appears in ready 
mode or after printing has completed, check the connection and/or whether an error has occurred.
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Operating system problems

2 

Common Mac problems

 

 

 

Refer to the Mac User’s Guide that came with your computer for further information on Mac error messages.

 

Condition Suggested solutions

The machine does not print PDF files 
correctly. Some parts of graphics, text, or 
illustrations are missing.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

Some letters are not displayed normally 
during cover page printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are displayed normally on 
the cover page.

When printing a document in Mac with 
Acrobat Reader 6.0 or higher, colors 
print incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.
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Operating system problems

3 

Common Linux problems

 

Condition Suggested solutions

The machine does not print. • Check if the printer driver is installed in your system. Open Unified Driver Configurator and switch to the Printers tab in the Printers 
configuration window to look at the list of available machines. Make sure that your machine is displayed on the list. If not, open 
Add new printer wizard to set up your device.

• Check if the machine is started. Open Printers configuration and select your machine from the printers list. Look at the description 
in the Selected printer pane. If its status contains Stopped, press the Start button. Normal operation of the machine should be 
restored. The “stopped” status might be activated when some problems in printing occur. 

• Check if your application has special print options such as “-oraw”. If “-oraw” is specified in the command line parameter, then 
remove it to print properly. For Gimp front-end, select “print” -> “Setup printer” and edit the command line parameter in the 
command item.

Some color images come out all 
black.

This is a known bug in Ghostscript (until GNU Ghostscript version 7.05) when the base color space of the document is indexed color 
space and it is converted through CIE color space. Because Postscript uses CIE color space for Color Matching System, you should 
upgrade Ghostscript on your system to at least GNU Ghostscript version 7.06 or later. You can find recent Ghostscript versions at 
www.ghostscript.com.

Some color images come out in 
unexpected color.

This is a known bug in Ghostscript (until GNU Ghostscript version 7.xx) when the base color space of the document is indexed RGB color 
space and it is converted through CIE color space. Because Postscript uses CIE color space for Color Matching System, you should 
upgrade Ghostscript on your system to at least GNU Ghostscript version 8.xx or later. You can find recent Ghostscript versions at 
www.ghostscript.com.

The machine does not print 
whole pages, and output is 
printed on half the page.

It is a known problem that occurs when a color machine is used on version 8.51 or earlier of Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript Bug 688252.The problem is solved in AFPL Ghostscript v. 8.52 or above. Download the 
latest version of AFPL Ghostscript from http://sourceforge.net/projects/ghostscript/ and install it to solve this problem.
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Operating system problems
 

I cannot scan via Gimp Front-
end.

Check if Gimp Front-end has Xsane:Device dialog. on the Acquire menu. If not, you should install Xsane plug-in for Gimp on the your 
computer. You can find Xsane plug-in package for Gimp on Linux distribution CD or Gimp home page. For the detailed information, 
refer to the Help for Linux distribution CD or Gimp Front-end application. 

If you wish to use another kind of scan application, refer to application’s Help.

“Cannot open port device file” 
error message appears when 
printing a document.

Avoid changing print job parameters (e.q., via LPR GUI) while a print job is in progress. Known versions of CUPS server break the print 
job whenever print options are changed and then try to restart the job from the beginning. Since Unified Linux Driver locks the port 
while printing, the abrupt termination of the driver keeps the port locked and unavailable for subsequent print jobs. If this situation 
occurs, try to release the port by selecting Release port in the Port configuration window.

The machine does not appear 
on the scanners list.

• Ensure your machine is attached to your computer, connected properly via the USB port, and is turned on.

• Ensure the scanner driver for your machine is installed in your system. Open Unified Linux Driver configurator, switch to Scanners 
configuration, then press Drivers. Make sure that driver with a name corresponding to your machine's name is listed in the window. 

• Ensure the port is not busy. Since functional components of machine (printer and scanner) share the same I/O interface (port), the 
situation of simultaneous access of different user applications to the same port is possible. To avoid possible conflicts, only one of 
them at a time is allowed to gain control over the device. The other user will encounter “device busy” response. This usually happens 
when starting a scan procedure. An appropriate message box appears.
To identify the source of the problem, open the Ports configuration and select the port assigned to your scanner, port's symbol /dev/
mfp0 corresponds to LP:0 designation displayed in the scanners’ options, /dev/mfp1 relates to LP:1, and so on. USB ports start at /
dev/mfp4, so scanner on USB:0 relates to /dev/mfp4 respectively and so forth sequentially. In the Selected port pane, you can see if 
the port is occupied by another application. If this is the case, you should either wait for completion of the current job or press the 
Release port button, if you are sure that the present port application is not functioning properly.

The machine does not scan. • Ensure a document is loaded into the machine, ensure your machine is connected to the computer.

• If there is an I/O error while scanning.

Condition Suggested solutions
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Operating system problems

 

Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.

 

4 

Common PostScript problems

The following situations are PS language specific and may occur when several printer languages are used.

 

 

Problem Possible cause Solution

The PostScript file cannot be 
printed

The PostScript driver may not be installed 
correctly.

• Install the PostScript driver (see "Software Installation" on page 96).

• Print a configuration page and verify that the PS version is available for 
printing.

• If the problem persists, contact a service representative.

Limit Check Error report prints The print job was too complex. You might need to reduce the complexity of the page or install more memory.

A PostScript error page prints The print job may not be PostScript. Make sure that the print job is a PostScript job. Check to see whether the software 
application expected a setup or PostScript header file to be sent to the machine.

The optional tray is not 
selected in the driver

The printer driver has not been configured to 
recognize the optional tray.

Open the PostScript driver properties, select the Device Options tab, and set the 
tray option.

When printing a document in 
Mac with Acrobat Reader 6.0 or 
higher, colors print incorrectly

The resolution setting in the printer driver may 
not be matched with the one in Acrobat Reader.

Make sure that the resolution setting in your printer driver matches the one in 
Acrobat Reader.
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Glossary

 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well as 
mentioned in this user’s guide.

 

802.11

802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards Committee (IEEE 
802). 

802.11b/g/n

802.11b/g/n can share same hardware and use the 2.4 GHz band. 802.11b 
supports bandwidth up to 11 Mbps, 802.11n supports bandwidth up to 150 
Mbps. 802.11b/g/n devices may occasionally suffer interference from 
microwave ovens, cordless telephones, and Bluetooth devices.

Access point

Access Point or Wireless Access Point (AP or WAP) is a device that connects 
wireless communication devices together on wireless local area networks 
(WLAN), and acts as a central transmitter and receiver of WLAN radio signals. 

ADF

An Automatic Document Feeder (ADF) is a scanning unit that will automatically 
feed an original sheet of paper so that the machine can scan some amount of the 
paper at once. 

AppleTalk

AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Mac (1984) and is now 
deprecated by Apple in favor of TCP/IP networking.

BIT Depth

A computer graphics term describing the number of bits used to represent the 
color of a single pixel in a bitmapped image. Higher color depth gives a broader 
range of distinct colors. As the number of bits increases, the number of possible 
colors becomes impractically large for a color map. 1-bit color is commonly 
called as monochrome or black and white.

BMP

A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file format 
on that platform.
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BOOTP

Bootstrap Protocol. A network protocol used by a network client to obtain its IP 
address automatically. This is usually done in the bootstrap process of 
computers or operating systems running on them. The BOOTP servers assign 
the IP address from a pool of addresses to each client. BOOTP enables 'diskless 
workstation' computers to obtain an IP address prior to loading any advanced 
operating system.

CCD

Charge Coupled Device (CCD) is a hardware which enables the scan job. CCD 
Locking mechanism is also used to hold the CCD module to prevent any damage 
when you move the machine.

Collation

Collation is a process of printing a multiple-copy job in sets. When collation is 
selected, the device prints an entire set before printing additional copies.

Control Panel

A control panel is a flat, typically vertical, area where control or monitoring 
instruments are displayed. They are typically found in front of the machine. 

Coverage

It is the printing term used for a toner usage measurement on printing. For 
example, 5% coverage means that an A4 sided paper has about 5% image or text 
on it. So, if the paper or original has complicated images or lots of text on it, the 
coverage will be higher and at the same time, a toner usage will be as much as 
the coverage.

CSV

Comma Separated Values (CSV). A type of file format, CSV is used to exchange 
data between disparate applications. The file format, as it is used in Microsoft 
Excel, has become a de facto standard throughout the industry, even among 
non-Microsoft platforms.

DADF

A Duplex Automatic Document Feeder (DADF) is a scanning unit that will 
automatically feed and turn over an original sheet of paper so that the machine 
can scan on both sides of the paper.

Default

The value or setting that is in effect when taking a printer out of its box state, 
reset, or initialized.
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DHCP

A Dynamic Host Configuration Protocol (DHCP) is a client-server networking 
protocol. A DHCP server provides configuration parameters specific to the DHCP 
client host requesting, generally, information required by the client host to 
participate on an IP network. DHCP also provides a mechanism for allocation of 
IP addresses to client hosts.

DIMM

Dual Inline Memory Module (DIMM), a small circuit board that holds memory. 
DIMM stores all the data within the machine like printing data, received fax data.

DLNA

The Digital Living Network Alliance (DLNA) is a standard that allows devices on 
a home network to share information with each other across the network.

DNS

The Domain Name Server (DNS) is a system that stores information associated 
with domain names in a distributed database on networks, such as the Internet.

Dot Matrix Printer

A dot matrix printer refers to a type of computer printer with a print head that 
runs back and forth on the page and prints by impact, striking an ink-soaked 
cloth ribbon against the paper, much like a typewriter.

DPI

Dots Per Inch (DPI) is a measurement of resolution that is used for scanning and 
printing. Generally, higher DPI results in a higher resolution, more visible detail 
in the image, and a larger file size.

DRPD 

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone company 
service which enables a user to use a single telephone line to answer several 
different telephone numbers.

Duplex

A mechanism that will automatically turn over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer equipped with 
a Duplex Unit can print on both sides of paper during one print cycle.

Duty Cycle

Duty cycle is the page quantity which does not affect printer performance for a 
month. Generally the printer has the lifespan limitation such as pages per year. 
The lifespan means the average capacity of print-outs, usually within the 
warranty period. For example, if the duty cycle is 48,000 pages per month 
assuming 20 working days, a printer limits 2,400 pages a day.
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ECM

Error Correction Mode (ECM) is an optional transmission mode built into Class 1 
fax machines or fax modems. It automatically detects and corrects errors in the 
fax transmission process that are sometimes caused by telephone line noise.

Emulation

Emulation is a technique of one machine obtaining the same results as another.

An emulator duplicates the functions of one system with a different system, so 
that the second system behaves like the first system. Emulation focuses on exact 
reproduction of external behavior, which is in contrast to simulation, which 
concerns an abstract model of the system being simulated, often considering its 
internal state.

Ethernet

Ethernet is a frame-based computer networking technology for local area 
networks (LANs). It defines wiring and signaling for the physical layer, and frame 
formats and protocols for the media access control (MAC)/data link layer of the 
OSI model. Ethernet is mostly standardized as IEEE 802.3. It has become the most 
widespread LAN technology in use during the 1990s to the present.

EtherTalk

A suite of protocols developed by Apple Computer for computer networking. It 
was included in the original Mac (1984) and is now deprecated by Apple in favor 
of TCP/IP networking. 

FDI

Foreign Device Interface (FDI) is a card installed inside the machine to allow a 
third party device such as a coin operated device or a card reader. Those devices 
allow the pay-for-print service on your machine.

FTP

A File Transfer Protocol (FTP) is a commonly used protocol for exchanging files 
over any network that supports the TCP/IP protocol (such as the Internet or an 
intranet).

Fuser Unit 

The part of a laser printer that fuses the toner onto the print media. It consists of 
a heat roller and a pressure roller. After toner is transferred onto the paper, the 
fuser unit applies heat and pressure to ensure that the toner stays on the paper 
permanently, which is why paper is warm when it comes out of a laser printer.
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Gateway

A connection between computer networks, or between a computer network 
and a telephone line. It is very popular, as it is a computer or a network that 
allows access to another computer or network.

Grayscale

A shades of gray that represent light and dark portions of an image when color 
images are converted to grayscale; colors are represented by various shades of 
gray.

Halftone

An image type that simulates grayscale by varying the number of dots. Highly 
colored areas consist of a large number of dots, while lighter areas consist of a 
smaller number of dots.

Mass storage device (HDD)

Mass storage device (HDD), commonly referred to as a hard drive or hard disk, is 
a non-volatile storage device which stores digitally-encoded data on rapidly 
rotating platters with magnetic surfaces.

IEEE

The Institute of Electrical and Electronics Engineers (IEEE) is an international 
non-profit, professional organization for the advancement of technology 
related to electricity.

IEEE 1284

The 1284 parallel port standard was developed by the Institute of Electrical and 
Electronics Engineers (IEEE). The term "1284-B" refers to a specific connector 
type on the end of the parallel cable that attaches to the peripheral (for example, 
a printer). 

Intranet

A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of an 
organization's information or operations with its employees. Sometimes the 
term refers only to the most visible service, the internal website.

IP address

An Internet Protocol (IP) address is a unique number that devices use in order to 
identify and communicate with each other on a network utilizing the Internet 
Protocol standard.
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IPM

The Images Per Minute (IPM) is a way of measuring the speed of a printer. An IPM 
rate indicates the number of single-sided sheets a printer can complete within 
one minute.

IPP

The Internet Printing Protocol (IPP) defines a standard protocol for printing as 
well as managing print jobs, media size, resolution, and so forth. IPP can be used 
locally or over the Internet to hundreds of printers, and also supports access 
control, authentication, and encryption, making it a much more capable and 
secure printing solution than older ones.

IPX/SPX

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet Exchange. It is a 
networking protocol used by the Novell NetWare operating systems. IPX and 
SPX both provide connection services similar to TCP/IP, with the IPX protocol 
having similarities to IP, and SPX having similarities to TCP. IPX/SPX was 
primarily designed for local area networks (LANs), and is a very efficient protocol 
for this purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO

The International Organization for Standardization (ISO) is an international 
standard-setting body composed of representatives from national standards 
bodies. It produces world-wide industrial and commercial standards.

ITU-T

The International Telecommunication Union is an international organization 
established to standardize and regulate international radio and 
telecommunications. Its main tasks include standardization, allocation of the 
radio spectrum, and organizing interconnection arrangements between 
different countries to allow international phone calls. A -T out of ITU-T indicates 
telecommunication.

ITU-T No. 1 chart

Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG

Joint Bi-level Image Experts Group (JBIG) is an image compression standard with 
no loss of accuracy or quality, which was designed for compression of binary 
images, particularly for faxes, but can also be used on other images.

JPEG

Joint Photographic Experts Group (JPEG) is a most commonly used standard 
method of lossy compression for photographic images. It is the format used for 
storing and transmitting photographs on the World Wide Web.
195 Glossary



Glossary

LDAP

The Lightweight Directory Access Protocol (LDAP) is a networking protocol for 
querying and modifying directory services running over TCP/IP.

LED

A Light-Emitting Diode (LED) is a semiconductor device that indicates the status 
of a machine.

MAC address

Media Access Control (MAC) address is a unique identifier associated with a 
network adapter. MAC address is a unique 48-bit identifier usually written as 12 
hexadecimal characters grouped in pairs (e. g., 00-00-0c-34-11-4e). This address 
is usually hard-coded into a Network Interface Card (NIC) by its manufacturer, 
and used as an aid for routers trying to locate machines on large networks.

MFP

Multi Function Peripheral (MFP) is an office machine that includes the following 
functionality in one physical body, so as to have a printer, a copier, a fax, a 
scanner and etc.

MH

Modified Huffman (MH) is a compression method for decreasing the amount of 
data that needs to be transmitted between the fax machines to transfer the 
image recommended by ITU-T T.4. MH is a codebook-based run-length 
encoding scheme optimized to efficiently compress white space. As most faxes 
consist mostly of white space, this minimizes the transmission time of most 
faxes. 

MMR

Modified Modified READ (MMR) is a compression method recommended by ITU-
T T.6.

Modem

A device that modulates a carrier signal to encode digital information, and also 
demodulates such a carrier signal to decode transmitted information.

MR

Modified Read (MR) is a compression method recommended by ITU-T T.4. MR 
encodes the first scanned line using MH. The next line is compared to the first, 
the differences determined, and then the differences are encoded and 
transmitted.
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NetWare

A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the network 
protocols were based on the archetypal Xerox XNS stack. Today NetWare 
supports TCP/IP as well as IPX/SPX.

OPC

Organic Photo Conductor (OPC) is a mechanism that makes a virtual image for 
print using a laser beam emitted from a laser printer, and it is usually green or 
rust colored and has a cylinder shape. 

An imaging unit containing a drum slowly wears the drum surface by its usage 
in the printer, and it should be replaced appropriately since it gets worn from 
contact with the cartridge development brush, cleaning mechanism, and paper.

Originals

The first example of something, such as a document, photograph or text, etc, 
which is copied, reproduced or translated to produce others, but which is not 
itself copied or derived from something else.

OSI

Open Systems Interconnection (OSI) is a model developed by the International 
Organization for Standardization (ISO) for communications. OSI offers a 
standard, modular approach to network design that divides the required set of 
complex functions into manageable, self-contained, functional layers. The layers 
are, from top to bottom, Application, Presentation, Session, Transport, Network, 
Data Link and Physical.

PABX 

A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL

Printer Command Language (PCL) is a Page Description Language (PDL) 
developed by HP as a printer protocol and has become an industry standard. 
Originally developed for early inkjet printers, PCL has been released in varying 
levels for thermal, dot matrix printer, and laser printers.

PDF

Portable Document Format (PDF) is a proprietary file format developed by 
Adobe Systems for representing two dimensional documents in a device 
independent and resolution independent format.
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PostScript

PostScript (PS) is a page description language and programming language used 
primarily in the electronic and desktop publishing areas. - that is run in an 
interpreter to generate an image.

Printer Driver

A program used to send commands and transfer data from the computer to the 
printer.

Print Media

The media like paper, envelopes, labels, and transparencies which can be used 
in a printer, a scanner, a fax or, a copier.

PPM

Pages Per Minute (PPM) is a method of measurement for determining how fast 
a printer works, meaning the number of pages a printer can produce in one 
minute.

PRN file

An interface for a device driver, this allows software to interact with the device 
driver using standard input/output system calls, which simplifies many tasks. 

Protocol

A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS

See PostScript.

PSTN

The Public-Switched Telephone Network (PSTN) is the network of the world's 
public circuit-switched telephone networks which, on industrial premises, is 
usually routed through the switchboard.

RADIUS

Remote Authentication Dial In User Service (RADIUS) is a protocol for remote 
user authentication and accounting. RADIUS enables centralized management 
of authentication data such as usernames and passwords using an AAA 
(authentication, authorization, and accounting) concept to manage network 
access.

Resolution

The sharpness of an image, measured in Dots Per Inch (DPI). The higher the dpi, 
the greater the resolution.
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SMB

Server Message Block (SMB) is a network protocol mainly applied to share files, 
printers, serial ports, and miscellaneous communications between nodes on a 
network. It also provides an authenticated Inter-process communication 
mechanism.

SMTP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions 
across the Internet. SMTP is a relatively simple, text-based protocol, where one 
or more recipients of a message are specified, and then the message text is 
transferred. It is a client-server protocol, where the client transmits an email 
message to the server.

SSID

Service Set Identifier (SSID) is a name of a wireless local area network (WLAN). All 
wireless devices in a WLAN use the same SSID in order to communicate with 
each other. The SSIDs are case-sensitive and have a maximum length of 32 
characters.

Subnet Mask 

The subnet mask is used in conjunction with the network address to determine 
which part of the address is the network address and which part is the host 
address.

TCP/IP

The Transmission Control Protocol (TCP) and the Internet Protocol (IP); the set of 
communications protocols that implement the protocol stack on which the 
Internet and most commercial networks run.

TCR

Transmission Confirmation Report (TCR) provides details of each transmission 
such as job status, transmission result and number of pages sent. This report can 
be set to print after each job or only after failed transmissions.

TIFF

Tagged Image File Format (TIFF) is a variable-resolution bitmapped image 
format. TIFF describes image data that typically come from scanners. TIFF 
images make use of tags, keywords defining the characteristics of the image that 
is included in the file. This flexible and platform-independent format can be 
used for pictures that have been made by various image processing 
applications.

Toner Cartridge

A kind of bottle or container used in a machine like a printer which contains 
toner. Toner is a powder used in laser printers and photocopiers, which forms 
the text and images on the printed paper. Toner can be fused by by a 
combination of heat/pressure from the fuser, causing it to bind to the fibers in 
the paper.
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TWAIN

An industry standard for scanners and software. By using a TWAIN-compliant 
scanner with a TWAIN-compliant program, a scan can be initiated from within 
the program. It is an image capture API for Microsoft Windows and Apple Mac 
operating systems.

UNC Path

Uniform Naming Convention (UNC) is a standard way to access network shares 
in Window NT and other Microsoft products. The format of a UNC path is: 
\\<servername>\<sharename>\<Additional directory>

URL

Uniform Resource Locator (URL) is the global address of documents and 
resources on the Internet. The first part of the address indicates what protocol to 
use, the second part specifies the IP address or the domain name where the 
resource is located.

USB

Universal Serial Bus (USB) is a standard that was developed by the USB 
Implementers Forum, Inc., to connect computers and peripherals. Unlike the 
parallel port, USB is designed to concurrently connect a single computer USB 
port to multiple peripherals.

Watermark

A watermark is a recognizable image or pattern in paper that appears lighter 
when viewed by transmitted light. Watermarks were first introduced in Bologna, 
Italy in 1282; they have been used by papermakers to identify their product, and 
also on postage stamps, currency, and other government documents to 
discourage counterfeiting.

WEP

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 802.11 to 
provide the same level of security as that of a wired LAN. WEP provides security 
by encrypting data over radio so that it is protected as it is transmitted from one 
end point to another.

WIA

Windows Imaging Architecture (WIA) is an imaging architecture that is originally 
introduced in Windows Me and Windows XP. A scan can be initiated from within 
these operating systems by using a WIA-compliant scanner.

WPA

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless (Wi-Fi) 
computer networks, which was created to improve upon the security features of 
WEP.
200 Glossary



Glossary

WPA-PSK

WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small business or 
home users. A shared key, or password, is configured in the wireless access point 
(WAP) and any wireless laptop or desktop devices. WPA-PSK generates a unique 
key for each session between a wireless client and the associated WAP for more 
advanced security.

WPS

The Wi-Fi Protected Setup (WPS) is a standard for establishing a wireless home 
network. If your wireless access point supports WPS, you can configure the 
wireless network connection easily without a computer.

XPS

XML Paper Specification (XPS) is a specification for a Page Description Language 
(PDL) and a new document format, which has benefits for portable document 
and electronic document, developed by Microsoft. It is an XML-based 
specification, based on a new print path and a vector-based device-
independent document format.
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